
Print Command 
File Menu

Print Button

Use this command to print a document. This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.
See Printing Tips for suggestions to help resolve printing problems.

Shortcut: CTRL+P

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection. Select the Setup option to change the 
printer and printer connection.

Setup
Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Page Prints the range of pages you specify in the From and To boxes.

Note that these pages refer to the pages of a multi-page document, not to multiple 
pages generated by tiling.

Print Quality
Select the quality of the printing. Generally, lower-quality printing takes less time to 
produce. Also, you may need to choose a lower print quality if your printer runs out of 
memory while printing a document.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.



File Menu Commands 
Menus

The File menu provides these commands for working with files:
New Create a new document.
Open Open an existing document.
Open as EasyArt Open an existing document in a floating EasyArt book.
Close Close an open document.
Save Save an open document using the same file name.
Save As Save an open document to a specified file name.
Print Print a document.
Print Preview Display the document on the screen as it would appear printed.
Print Setup Select a printer and printer connection.
Import Import a drawing created in another application.
Export Save a drawing in a format that can be read by another application.
1, 2, 3, 4 Files Open a recently accessed file.
Exit Exit SmartSketch.



Remove Transform Command 
Object Menu

SmartSketch keeps track of all scaling and rotation performed on objects. You can remove 
this scaling and rotation with the Remove Transform command. This is particularly useful to 
return text and embedded objects to their actual size.



Page Commands 
Format Menu

Every SmartSketch document can consist of multiple drawing pages. This allows you to keep
related drawings in a single file and quickly compare them. The Page commands are used to 
manage these pages. Note that none of the Page commands are affected by the Undo 
command.
You can quickly turn between pages by showing the Page tabs with the Page Tabs command 
in the View menu. Or you can turn pages with the keyboard shortcuts.
Add Page

Add a new page to the current document immediately after the current page and display 
the new page in the current window. If the page tabs are not currently visible, they will 
be shown.

Delete Page
Delete the current page. This command is unavailable if there is only one page in the 
current document.

Rename Page
Rename the current page.

See Also
Page Tabs
Keyboard Shortcuts for Turning Pages



Edit Menu Commands 
Menus

The Edit menu offers these commands:
Undo Reverse previous editing operation.
Redo Redo the previously undone action.
Cut Delete selected data from the document and move it to the Clipboard.
Copy Copy selected data from the document to the Clipboard. The original 

data remains in place.
Paste Paste data from the Clipboard into the document.
Paste Special Paste data from the Clipboard with special options.
Clear Delete the selection.
Duplicate Make a copy of the selection and offset it from the original.
Select All Select the entire contents of the window.
Insert Object Insert and embed an object, such as a chart or an equation in a 

document.
Links List and edit links to embedded documents.
Object Provide commands for editing linked and embedded objects.



Scale by Percent Command 
Format Menu

Scale the current selection by an exact percentage. Note that the percentage must be 
between 10% and 1000%.



Align Command 
Format Menu

Align Button

You can use the Align command to align and evenly space (distribute), as well as match the 
dimensions of the selected objects in your SmartSketch drawing. When two or more objects 
are selected, the Align command is available.
There are three sets of options that can be used individually or in combination: vertical 
alignment and distribution; horizontal alignment and distribution; and dimension matching.

Vertical
To align or distribute the selected items vertically on the page, select a vertical option:

Don't move the selected items vertically.

Align the tops of the selected items.

Align the centers of the selected items.

Align the bottom edges of the selected items.

Distribute the selected items vertically so the gaps between them are equal.

Distribute the selected items vertically so their tops are equidistant.

Distribute the selected items vertically so their centers are equidistant.

Distribute the selected items vertically so their bottom edges are equidistant.
Horizontal
To align or distribute the selected items horizontally, select a horizontal option:

Don't move the selected items horizontally.

Align the left edges of the selected items.



Align the centers of the selected items.

Align the right edges of the selected items.

Distribute the selected items horizontally so the gaps between them are equal.

Distribute the selected items horizontally so their left edges are equidistant.

Distribute the selected items horizontally so their centers are equidistant.

Distribute the selected items horizontally so their right edges are equidistant.

Match
To match the sizes of the selected items:

Don't change the size of the selected items.

Make all of the items the same width.

Make all of the items the same height.

Make all the the items have the same height and width.
When matching sizes, SmartSketch will make all of the objects as large as the largest 
selected object.

The Alignment Rectangle
When aligning and evenly spacing objects, SmartSketch aligns and spaces the selected 
objects based on an imaginary rectangle that tightly encloses the entire selection.

Before

After



After applying the Align command with align tops and evenly space horizontally, note how 
the tops of the objects are aligned with the top of the rectangle that encloses the objects. 
Also note that the horizontal positions of the red triangle and blue pentagon did not change, 
since they were the left-most and right-most objects.
Distinguishing Objects
The Align command can be somewhat unpredictable when aligning selected lines and fills. 
Lines and fills that overlap after an alignment, distribution, or match size, will be connected. 
To avoid this problem, it is best to group any lines or fills into group objects before aligning 
them.



View Menu Commands 
Menus

The View menu changes the appearance of SmartSketch and your drawing with these 
commands:

Toolbars Choose options about how the toolbars are displayed.
Rulers Show or hide the rulers.
Page Tabs                   Show or hide the page tabs.
Outlines                      Show only the outlines of the drawing.
Normal Show the normal view of the drawing.
Smooth Smooth the edges of shapes in the drawing.
Smooth Text Smooth the edges of shapes and text in the drawing.
Show Page Zoom to show the entire page.
Show All Zoom to show the entire contents of the page.
100% Show the document at actual size.



Window Menu Commands 
Menus

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Create a new window that views the same document.
Cascade Arrange windows in an overlapped fashion.
Tile Arrange windows in non-overlapped tiles.
Arrange Icons Arrange icons of closed windows.
Window 1, 2, ... Go to specified window.



Help Menu Commands 
Menus

The Help menu offers these commands, which provide you assistance with SmartSketch: 
Contents Provide an index to the major help topics.
Search for Help on Search for help on a specific topic.
Learning SmartSketch Lessons for learning about SmartSketch.
EasyArt Finder Search for EasyArt images.
Reference Information Browse through the on-line Help information.
Technical Support How to get answers to questions about SmartSketch.
About SmartSketch Display the version number of SmartSketch.



Tools
Reference Information

All drawing and editing in SmartSketch is done using one of the eight tools. The tools appear
in a row in the Drawing toolbar, with the currently selected tool depressed. To select a tool, 
simply click on its icon.
To get information on a tool and its modifiers, click the buttons below.

Arrow

Pencil

Brush

Eraser

Text tool

Dropper

Magnifier

Lasso
See Also

Keyboard Shortcuts to Switch Tools



New Command 
File Menu

New Button

Use this command to create a new SmartSketch document.
You can open an existing document with the Open command.

Shortcut: CTRL+N



Open Command 
File Menu

Open Button

Use this command to open an existing document in a new window. You can open multiple 
documents at once. Use the Window menu to switch among the multiple open documents. 
See Window 1, 2, ... command.
You can create new documents with the New command.
If you want to open a file created in an application other than SmartSketch, use the Import 
command.

Shortcut: CTRL+O

The following options in the File Open dialog box allow you to specify which file to open:
File Name

Type or select the file name you want to open. This box lists files with the extension you 
select in the List Files of Type box.

List Files of Type
SmartSketch drawing files should always end with ".SSK", but if they don't, you can 
choose to view a list of all files.

Drives
Select the drive in which SmartSketch stores the file you want to open.

Directories
Select the directory in which SmartSketch stores the file that you want to open.

Network
Choose this button to connect to a network location, assigning it a new drive letter.



Edit Page Command 
Object Menu

Choose the Edit Page command to stop editing a group object and return to editing the 
entire drawing. This command is only available if you are currently editing a group object. 

Shortcut: Double-click on an empty area of the drawing



Close Command
File Menu

Closes the active document. If the document is displayed in more than one window, this 
command closes all of the windows that contain the active document. If you have not saved 
your changes to the document, SmartSketch suggests that you save changes to your 
document before you close it. If you close a document without saving, you lose all changes 
made since the last time you saved it. Before closing an untitled document, SmartSketch 
displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by clicking the Close icon in the upper left corner of the 
document's window, as shown below:



Save Command 
File Menu

Save Button

Use this command to save the active document to its current name and directory. When you 
save a document for the first time, SmartSketch displays the Save As dialog box so you can 
name your document. If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcut: CTRL+S



Drawing Toolbar

The Drawing toolbar displays the tool buttons and their modifiers. There are eight tools in 
the tools section. To left of the tools is the tool modifier section. This section is used to 
control the behavior of each tool; its appearance depends on which tool is currently 
selected. Some tools like the Text tool have many modifiers, while others like the Dropper 
have none. 
Note that if the window is not wide enough to display the modifiers next to the tools, they 
will be displayed below the tools.

To find out what action a button performs, use the mouse to place the pointer over a button 
to activate the ToolTips, or use the Help button to activate the help mode.



Save As Command 
File Menu

Use this command to save and name the active document. SmartSketch displays the Save 
As dialog box so you can name your document. 

To save a document with its existing name and directory, use the Save command.

If you want to save a drawing in a format that applications other than SmartSketch can 
understand, use the Export command.

The following File Save As dialog box options allow you to specify the name and location of 
the file you're about to save:
File Name

Type a new filename to save a document with a different name. A filename can contain 
up to eight characters and an extension of up to three characters. SmartSketch 
automatically adds the ".SSK" extension if you don't provide an extension.

Save File As Type
All files are saved in the SmartSketch format.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network
Choose this button to connect to a network location, assigning it a new drive letter.



1, 2, 3, 4 File Commands 
File Menu

Refers to the files listed at the bottom of the File menu. The names on the list are the last 
four files you previously opened. To open one of these files, select the file name you want 
from the list.



Exit Command 
File Menu

Use this command to end your SmartSketch session. You can also use the Close command 
on the application Control menu. SmartSketch prompts you to save documents with unsaved
changes.

Shortcuts
Mouse: Double-click the application's Control menu button

Keys: ALT+F4



Undo Command 
Edit Menu

Undo Button

Use this command to reverse the last editing action. SmartSketch remembers and can undo 
or redo your last 20 actions. Any action that you undo can be redone with the Redo 
command.

Shortcut: CTRL+Z 



Redo Command 
Edit Menu

Redo Button

Redo the last action undone with the Undo command. The command is not available if there 
is nothing to redo. Note that redo is unavailable if you have changed the drawing since the 
last Undo command.

Shortcut: CTRL+Y



Cut Command 
Edit Menu

Cut Button

Use this command to remove the currently selected data from the document and put it on 
the Clipboard. This command is unavailable if there is no data currently selected.
Cutting data to the Clipboard replaces the contents previously stored there.
Once an image is on the Clipboard, it can be pasted into a SmartSketch drawing or into 
another application.

Shortcut: CTRL+X



Copy Command 
Edit Menu

Copy Button

Copies the selection onto the Clipboard. This command is unavailable if there is no selection.
Copying data to the Clipboard replaces whatever was previously stored there.
Once an image is on the Clipboard, it can be pasted into a SmartSketch drawing or into 
another application.

Shortcut: CTRL+C



Paste Command 
Edit Menu

Paste Button

Use this command to insert a copy of the Clipboard contents centered in the window. If you 
are editing text with the text tool and text is on the Clipboard, the text will be inserted at the
current insertion point. This command is unavailable if the Clipboard is empty.

Shortcut: CTRL+V



Toolbars Command 
View Menu

Allows you to show, hide and change the look of SmartSketch's toolbars.
Toolbars

The check boxes control whether the toolbars are visible in SmartSketch.
The Standard Toolbar contains shortcuts for accessing menu commands.
The Drawing Toolbar contains all of the SmartSketch drawing tools and their modifiers.
The Status Bar shows information about the menu commands and about the state of the 
Caps Lock and Num Lock keys.

Color Buttons
Displays colored buttons. Deselect this check box if you have a black-and -white monitor 
and want to display the buttons with more contrast.

Large Buttons
Displays larger toolbar buttons. If your monitor has a higher resolution, you may want to 
use the larger buttons.

3-D Controls
Displays the dialog box controls. Deselect this check box if you don't want to use the 3-D 
controls.

Show ToolTips
Display the ToolTips when the cursor pauses over a toolbar button. Deselect this check 
box if you don't want to see the ToolTips.



Standard Toolbar

The Standard toolbar is displayed across the top of the application window, below the menu 
bar. The toolbar provides quick mouse access to many commands used in SmartSketch.
To hide, display or change the icon size of the toolbar, choose the Toolbars command.

To find out what action a button performs, pause over a button with the mouse to activate 
the ToolTips, or use the Help button to activate the help mode.



Object Menu 
Edit Menu

The Object menu in the Edit menu provides commands for working with objects that have 
been created in other applications:
Edit/Open Object
Open an embedded object or the source file of linked information so that you can edit it. Edit
tries to edit the object in the SmartSketch document, while Open will edit the object in the 
application that created it.
Other commands can also appear here depending on the type of object selected.
Convert Object
The Convert Object command and dialog box are used to convert an object from one type to 
another.
Change Icon
The Change Icon dialog box allows you to choose a different icon for an object that is 
displayed as an icon.



Paragraph Command 
Format Menu

Paragraph Button (Text tool)

The Paragraph command changes the current settings of the Text tool and any selected text.
Indent
Set the indent of the first line relative to the left margin.

Left margin
Set the left margin relative to the edge of the text box.
Right margin
Set the space between the text and the right edge of the text box.
Line spacing
Set the space between adjacent lines. Note that a line will always be tall enough for the 
largest font on that line.



Status Bar

The status bar is displayed at the bottom of the SmartSketch window. To display or hide the 
status bar, use the Toolbars command in the View menu.
The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus. This area similarly shows messages that describe the actions of 
toolbar buttons when the mouse pauses over a button and the ToolTips are displayed.
The right areas of the status bar indicates the current time and which of the following keys 
are latched down:
Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.



New Window Command
Window Menu

Use this command to open a new window with the same contents as the active window. You 
can open multiple document windows to display different parts or views of a document at 
the same time. If you change the contents in one window, all other windows containing the 
same document reflect those changes. When you open a new window, it becomes the active
window and is displayed on top of all other open windows.
This command is particularly useful when you want to work on two different pages of the 
same document at the same time.



Cascade Command 
Window Menu

Use this command to arrange multiple open windows in an overlapping fashion.



Pencil Tool
Tools

The Pencil is used to quickly draw lines and shapes, just like a real pencil. But that is where 
similarity to a real pencil ends. With SmartSketch, as you draw them, lines can be 
straightened, curves smoothed and basic geometric shapes recognized and corrected, all 
automatically. In addition, you can manually reshape lines at any time. Lines drawn with the 
Pencil have three attributes: color, thickness, and dash pattern.
The Pencil modifiers let you control how the lines you draw are to be processed, if at all.

Pencil Modifiers
When the Pencil is selected, there are five modifiers displayed. From left to right, the 
modifiers are: Pencil Mode, Ink Bottle, Line Color, Line Thickness, and Line Dash.

Pencil Mode
Opens the Pencil Mode menu. The following options control how SmartSketch processes the 
lines you draw:

Straighten causes SmartSketch to perform line and shape recognition; this includes 
connecting separate lines, straightening lines, smoothing curves, and recognizing shapes. 
See Shapes Recognized by SmartSketch for descriptions of the shapes that will be 
recognized.

Smooth disables line straightening and shape recognition so you can draw curved lines 
without them being altered; curves are still smoothed slightly and lines that end near 
another are still joined to the nearest line.

Ink causes lines to be left as you drew them. In other words, lines are not smoothed, 
straightened, or joined—just like lines drawn with a real pencil.

Oval provides a quick way to draw a perfect oval or circle shape. Simply drag from one 
corner to the diagonally opposite corner of a rectangle that encloses the desired oval.

Rectangle works like like oval option to create a precise rectangle.

Line draws a straight line by dragging from a starting point to the end.

Ink Bottle
If the Ink Bottle button is down, the Pencil can be used to change the color, thickness and 
dash pattern of existing lines. Simply click on any line in your drawing to apply the current 
Pencil settings to the line. If you click on a selected line, all of the selected lines will be 



changed. Note that the Dropper tool can be useful when changing line styles. Also note that 
the Ink Bottle will not have an effect on lines in a group object.
Line Color
Click on the color pop-up to select a line color. Select one of the colors from the list.

If you choose the Color button, you can create a new color with the Colors command.

Line Thickness
Click the line thickness pop-up to change the Pencil line thickness. The line thickness can 
range from a hairline up to 10 points. Note that you may not be able to see the difference 
between some of the thinner line thicknesses on the screen, but they will appear properly on
high resolution printers and when you zoom in on your drawing.
To choose a line thickness not in the menu, choose Custom from the menu and enter a line 
thickness in the dialog box. This line thickness will then appear as the last line thickness in 
the menu until you change it again.

Line Dash
Choose a solid line or one of the predefined dash patterns.



Tile Command 
Window Menu

Use this command to arrange multiple open windows side by side.



Arrange Icons Command 
Window Menu

Use this command to arrange the icons for minimized windows at the bottom of the main 
window. If there is an open document window at the bottom of the main window, some or all 
of the icons may not be visible because they will be underneath this document window.



1,2,... Command 
Window Menu

SmartSketch displays a list of currently open document windows at the bottom of the 
Window menu. A check mark appears in front of the document name of the active window. 
Choose a document from this list to make its window active.



Paste Special Command 
Edit Menu

Pastes or embeds the Clipboard contents in a specified format. It is also used to create a link
to information in another document.
Source

Displays the name of the source data and its location.
Paste

Insert the Clipboard contents into your drawing.
Paste Link

Insert the Clipboard contents into your drawing and create a link to another application 
so that the information is automatically updated when it changes.

As
Choose the type of information you want to paste:
Object
The picture of an object and the information needed to edit the object. The name of the 
object depends on the application that created the object. The object can later be 
converted to an editable SmartSketch drawing with the Break Apart command.
Picture (Metafile)
An image that SmartSketch will convert to a format that can be edited in SmartSketch.
Text (ASCII)
Unformatted text.
Text (Native)
Text copied in SmartSketch with its formatting information.
SmartSketch Drawing
A portion of a SmartSketch drawing.

Display As Icon
Display the link as an icon in your drawing.

Result
Describes the result of the selection operation.

Change Icon
Choose a different icon if the Display As Icon box is checked.



About SmartSketch Command 
Help Menu

Use this command to display the copyright notice and version number of SmartSketch.



Help Button

Help Button

Use the Help button to get help on a SmartSketch button, menu or window.
When you click the Help button in the Standard toolbar, the mouse pointer changes to an 
arrow and question mark. Use this pointer to click somewhere in the SmartSketch window, 
such as on another toolbar button. The Help topic will be shown for the item you clicked.

Shortcut: SHIFT+F1



Title Bar

The title bar is located along the top of a window. It contains the name of the application and
document.
To move the window, drag the title bar.
A title bar may contain the following elements:

Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll Bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document. You can use 
the mouse to scroll to other parts of the document.
Drag the scroll boxes to scroll through the document. Note that the screen will update as you
drag.
Click the arrows to scroll in 30-pixel steps.
Click in the space between the scroll box and the arrows to scroll a screen full at a time.
The scroll bars will be hidden if the entire page fits in the window.



Size Command (System Menu)

Use this command to display a four-headed arrow; you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the direction keys (left, right, up, or down arrow key) to move the pointer to 

the border you want to move. 
2. Press a direction key to move the border.
3. Press Enter when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut Drag the size bars at the corners or edges of the window



Move Command (Control Menu)

Use this command to display a four-headed arrow; you can move the active window or dialog
box with the arrow keys.

Note: This command is unavailable if you maximize the window.

Shortcut CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the SmartSketch window to an icon.

Shortcut

Mouse: Click the minimize icon on the title bar.
Keys: ALT+F9



Maximize Command (System Menu)

Use this command to enlarge the active window to fill the available space.

Shortcut: Click the maximize icon on the title bar; or double-click the title bar.
CTRL+F10 enlarges a document window.



Next Window Command (Document Control Menu)

Use this command to switch to the next open document window. SmartSketch determines 
which window is next according to the order in which you opened the windows.

Shortcut CTRL+F6



Previous Window Command (Document Control Menu)

Use this command to switch to the previous open document window. SmartSketch 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut SHIFT+CTRL+F6



Close Command (Control Menus)

Use this command to close the active window or dialog box.

Double-clicking a Control menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the 
document Control menu closes only one window at a time. You can close all windows at once
by choosing the Close command on the File menu.

Shortcuts
CTRL+F4 Close the document window
ALT+F4 Close the SmartSketch window or dialog box



Restore Command (Control Menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to Command (Application Control Menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or
close an application on the list.

Shortcut CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar. This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Rulers Command 
View Menu

SmartSketch's rulers can be used to quickly measure the size of parts of your drawing.
The Rulers command in the View menu is used to show or hide the rulers on the current 
window.
The Document command in the Format menu can be used to change the measurement units
that are shown on the rulers.



Selecting Parts of the Drawing

Frequently, it is important for SmartSketch to perform an action on part of your drawing. For 
example you may want to delete or move part of your drawing. You indicate to SmartSketch 
what part of the drawing to act on by selecting it.
SmartSketch shows the selected portion of a drawing by making it appear "textured." The 
example below shows several selected elements.

The selected text object is indicated by a textured rectangle surrounding the word "Text." 
The selected blob-shaped fill is indicated by the textured pattern. The selected circular line 
is indicated by the angle-pattern texture on the line.
There are several different ways to select parts of your drawing. Most selecting is done by 
clicking or dragging out a selection rectangle with the Arrow. The Lasso will select an 
arbitrarily shaped portion of your drawing. The Select All command will select all of your 
drawing.
You can deselect all of your drawing by clicking anywhere with the Lasso, or by clicking on 
an empty portion of your drawing with the Arrow.



Clear Command 
Edit Menu

Deletes the current selection.
Shortcut: Delete



Import Command 
File Menu

The Import command is used to import graphics created in other applications into 
SmartSketch.
SmartSketch knows how to import drawings saved in the Window Metafile, Adobe Illustrator 
EPS, and AutoCAD DXF formats.
Importing Unknown File Formats
If you import a file in a format the SmartSketch does not understand, SmartSketch will offer 
to import it as an embedded object. This works just like inserting a file with the Insert Object 
command. The PaintBrush application that is provided with Windows 3.1 understands and 
will import several bitmap formats. If there is no application on your computer that will 
import a given file format, it will be displayed as an icon.

Choosing a File
The following options in the Import dialog box allow you to specify which file to import:
File Name

Type or select the file name you want to open. This box lists files with the extension you 
select in the List Files of Type box.

List Files of Type
Select the type of file you want to see in the File Name list. To see all types of files that 
SmartSketch understands, select All Formats.
SmartSketch can Import the following graphic file formats:
Windows Metafile (*.WMF)
Adobe Illustrator EPS (*.EPS, *.AI)
AutoCAD DXF (*.DXF)
You can also specify a custom file type to import.

Drives
Select the drive that contains the file that you want to open.

Directories
Select the directory that contains the file that you want to open.

Network
Press this button to connect to a network location, assigning it a new drive letter. 



Arrow Tool
Tools

The Arrow tool is used to select, reshape and move parts of the drawing.
Selecting
Clicking on part of the drawing will select that part of the drawing. Clicking on a fill will 
select the entire filled area. Clicking on a line will select the line segment. Line segments 
begin and end at any corner or change in color or thickness. Clicking on an object will select 
that object. Press the Shift key to deselect something that is already selected.
Double-clicking on a line will select the line past any corners but will stop at any change in 
color or thickness. Double-clicking on a filled area will select the filled area, including any 
line touching the filled area and any lines or fills surrounded by the filled area.
To select an area, press on a empty portion of the drawing and drag a rectangle that 
completely encloses the area to be selected. Pressing the Shift key as you do so will add this
area to the current selection.
To deselect everything, click on an empty portion of the drawing. If there are no empty areas
visible, click with the Lasso to deselect everything.

Reshaping
To reshape, simply drag any unselected line.
Moving the Selection
To move the selection, simply drag any portion of the selection.

Editing an Object
To quickly edit an object, simply double-click on the object with the Arrow tool. See the Edit 
Object command for more information.

See Also
Selecting Parts of the Drawing
Reshaping Lines
Moving Parts of the Drawing
Snapping
Modifier Keys When Dragging
Keyboard Shortcuts for Moving the Selection



Tiling
The process SmartSketch uses to print a single large document on multiple sheets of paper; 
these sheets can then be pieced together to show the entire document.



SmartSketch Document Window

This is where your SmartSketch drawing is displayed.
Choose a tool from the Drawing toolbar and create and edit your drawing in this view.
To change your view of the drawing, use the View menu, zoom control, or Magnifier to 
reduce or enlarge your view. Use the scroll bars to see a different portion.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message.



Export Command 
File Menu

Use the Export command to save the current page of your drawing in a format that can be 
understood by other applications.
Use the following options to choose a file and format for saving your drawing:

File Name
Type a new file name to export your drawing to. A file name can contain up to eight 
characters and an extension of up to three characters.

Save File As Type
Select the format you want to save your drawing in. SmartSketch supports the following 
formats:
Windows Metafile (*.WMF)
Adobe Illustrator EPS (*.EPS, *.AI)
AutoCAD DXF (*.DXF)

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network
Choose this button to connect to a network location, assigning it a new drive letter.



Print Progress Dialog

The Printing Progress dialog box is shown during the time that SmartSketch is sending 
output to the printer. The page number indicates the progress of the printing.
To abort printing, choose Cancel.



Print Preview Command 
File Menu

Use this command to display the active document as it would appear when printed. When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format. The Print Preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.
This command is useful for seeing how your document will print when the pages are tiled.



Print Preview Toolbar

The Print Preview toolbar provides the following options:
Print

Bring up the Print dialog box to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from Print Preview to the editing window.



Print Setup Command 
File Menu

The Print Setup command and dialog box allow you to select the destination printer, its 
connection and how your drawing is placed on the printer paper.
See the Drawing Layout on the Printer for tips on how to select these options. See Printing 
Tips for suggestions to help resolve printing problems.
Printer

Select the printer you want to use. Select the Default Printer; or select the Specific 
Printer option, then select one of the current installed printers shown in the box. You 
install printers and configure ports using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network
Choose this button to connect to a network location, assigning it a new device name.

Margins
Specify the space between the edge of the drawing and the edge of the printer paper. 
Note that most printers cannot print to the edge of the paper. If your drawing gets cut off
on the edges, you should enlarge the margins.
Specifying Center Left/Right or Top/Bottom will center the drawing on the printer paper.

Scaling
Use the Scale percentage option to enlarge or reduce the size of your drawing when 
printed. Note that some printer drivers allow you to specify a Scaling factor in the 
Options dialog box. However, it is best to change the scaling here in the Print Setup 
dialog box to avoid confusion.
Fit on one page will ensure that you document is automatically reduced or enlarged so 
that it fills a single printer page.

Disable PostScript Output
This button only has an effect when printing to a PostScript printer.
SmartSketch uses several optimizations to make printing to a PostScript printer faster 
and more efficient. Unfortunately, these optimizations may cause problems with older 
PostScript Level 1 printers. If you get PostScript error messages when printing a file, try 
printing with this option selected. If printing to a PostScript printer is very slow, it may be
because this option is selected.



Update Command 
File Menu

The Update command is only visible when editing a SmartSketch object that is embedded in 
another application. Much like the Save command, it will save any changes you have made 
to the SmartSketch object. You never need to choose this command, since the object will be 
saved automatically for you.



Links Command 
Edit Menu

Use this command to display the standard Links dialog box, which lets you edit links 
between your document and other documents. This command is typically used by advanced 
users.

This command is unavailable if you have no links in your document.



Insert Object Command
Edit Menu

Inserts and embeds an object, such as a chart or an equation, in a document. The 
application in which the object was created becomes active on the screen.
Create New
Choose an object type to insert into your drawing. A new object will be inserted in the center
of the Window.
Create from File
Create an object in your drawing from an existing file. If you want your drawing to be 
updated when the original file is modified, select the Link option.



Windows Metafile File Format (.WMF)

Windows Metafile format is the standard Windows graphics format and is supported by most 
Windows applications. Importing and exporting files in this format will provide good results. 
Note: SmartSketch (like most Windows applications) creates and requires Metafiles in the 
"Placeable Metafile Format."



Duplicate Command 
Edit Menu

Quickly makes a copy of the current selection and offsets it slightly from the original.

Shortcut: CTRL+D



Select All Command 
Edit Menu

Select the entire contents of the current window.

Shortcut: CTRL+A



Brush Tool
Tools

Use the Brush to draw brush-like strokes and to fill enclosed areas. A number of brush colors,
shapes and sizes are available, and the Brush modifiers provide complete control of the 
Brush operation. Note that brush strokes are always drawn into the drawing layer and that 
they never affect any objects. The brush is the only way to create new fills in SmartSketch.
Brush Modifiers
When the Brush is selected, five modifiers are displayed on the Tool palette. From left to 
right, the modifiers are: Brush Mode, Paint Bucket, Brush Color, Brush Size, Brush Shape. If 
your computer is attached to a pressure-sensitive pen tablet, a sixth pressure modifier will 
appear.
Brush Mode
The Brush Mode controls how brush strokes are applied to the drawing. Paint Normal is used 
for most drawing, but the other modes provide powerful special effects.

Paint Normal will draw on top of any lines or fills in the drawing layer.

Paint Fills will cover any fills in the drawing layer but leave lines untouched.

Paint Behind will only paint on transparent areas of the drawing layer.

Paint Selection covers only selected fills in the drawing layer.

Paint Inside paints only on the fill area on which you begin a Brush stroke, and will never 
paint over lines. This works much like a "smart" coloring book, in which you can never paint 
outside of the lines. If you start painting from an empty point, the stroke will not affect any 
existing filled areas.

Paint Bucket

When the Paint Bucket is selected, the Brush can be used to fill in enclosed areas with a new
color. Simply click in the area you want to fill, and SmartSketch will fill it. This is use both to 
fill empty areas and to change the color of existing fills. If you click on a selected fill, all of 
the selected fills will be changed to the new color.

Close Gaps

Frequently, tiny gaps that are difficult to see can prevent an area from being completely 



enclosed. The Close Gaps option appears when the Paint Bucket is selected and provides a 
solution for this problem. SmartSketch will look for any gaps and try to close them before 
filling the area. This is a complex process and can take time. Also, sometimes SmartSketch 
cannot find all of the gaps, so you will have to zoom in and close them manually.
Choose Don't Close Gaps if you want to close the gaps yourself--this can be faster for 
complex drawings.

Brush Size and Shape
The Brush Size and Brush Shape modifiers control the tip of the brush. You can combine any 
size and shape settings to create a variety of custom brush tips.

Brush Color
Click on the color pop-up to select a brush color from the list.

If you choose the color button, you can create a new color using the Colors command.
Note: Painting with white is not the same as erasing--you are creating an item filled with 
white that can be selected, moved and reshaped like any other fill item.
Pressure Modifier

If you have a pressure-sensitive pen tablet, the pressure modifier will appear to enable the 
pressure-sensitive control of the Brush tip size. See Using a Pen With SmartSketch for more 
information.



Eraser Tool
Tools

The Eraser does just what you’d expect--it erases lines and fills. It can be customized to 
erase just lines, just fills, just the selected fills, or just the fill on which you start erasing. The 
Eraser can be round or square, in one of five sizes, and the Erase Mode controls its behavior.
Note that the eraser can only erase lines and fills in the drawing layer; it cannot erase 
objects. If you need to erase part of an object, either edit the object, or break the object 
apart.

Eraser Modifiers
When the Eraser is selected, three modifiers are available; from left to right, they are: Erase 
Mode, Eraser Faucet, and Eraser Size/Shape.

Erase Mode
The Erase Mode controls how the Eraser erases the drawing. They perform a similar function
to a traditional erasing shield. These modifier modes are very similar to the Brush Modes.

Normal erases both lines and fills as it passes over them.

Erase Fills removes only fills; existing lines are not affected.

Erase Lines erases only lines; areas of fill are not affected by the Eraser strokes.

Erase Selected Fills erases only the selected fills and will not affect lines.

Erase Inside erases only the area of fill on which you begin the Eraser stroke. (If you begin 
erasing from an empty point, nothing will be erased.) Lines are unaffected by the Eraser in 
this mode.
Eraser Faucet

When the Eraser is selected, you can quickly delete a complete line segment or area of fill 
with the Faucet tool. Click the item to be removed. You can erase lines or fills with this 
command. If you click on a selected line or fill, all of the selected lines or fills will be erased.

Eraser Size/Shape
Choose a size and shape for the Eraser. The Eraser can be either round or square, in one of 
five sizes.

See Also



Clear command



Text Tool
Tools

The Text tool lets you create and edit text objects in your drawing.
Creating a New Text Object
Click to create a label text object. Label text will automatically expand both vertically and 
horizontally to contain whatever text you enter.
Drag out a text box to create a text block object. This allows you to specify a fixed width for 
the text object, but the it will still expand vertically as you enter more text.
The new text object will be created with the current Text tool settings. Once you have 
created the new text object and see the flashing insertion point, you are free to type and 
edit, just like in your favorite word-processing program. If you do not type anything into the 
text object, SmartSketch will automatically remove it for you.

Editing an Existing Text Object
To activate an existing text object for editing, simply click in it with the Text tool, or double-
click on it with the Arrow. You should then see the flashing insertion caret, and be free select 
and enter text.
Note that since the Text tool is used for editing the contents of text objects; it cannot be 
used to select multiple text objects. If you want to change the text style of multiple text 
objects, select them with Arrow, then select the Text tool to change the style.
Changing the Width of Text Objects
You can shrink or enlarge a text object with the Scale command, but this simply enlarges or 
reduces the size of the text object. If you want to change the amount of text on a line, click 
in the text object with the Text tool and drag the handle in the upper right corner. If the 
handle is round, you have a label text object that will shrink or expand its width to fit the 
available text. If the handle is square, you have a block text object which will wrap the text 
to fit in the block. To change a block text object to a label text object, double-click on the 
handle.

Text Tool Modifiers
When the Text tool is selected, five modifiers are displayed on the Tool palette. From left to 
right, these are: Font, Size, Color, Style, Alignment.

Font
The font box indicates the currently selected font. Choosing a new font to change the font of 
the current selection and will set the font used for the next text object created.
You can also change the font, size and style by using the Font command. This allows you to 
preview a font before selecting it.
Size
Choose the font size by selected a standard size from the pop-up menu, or by typing a size 
into the box.
Color
Click on the Color pop-up to select a text color.



If you select the Color button, you can create a new color using the Colors command.
Style

Press the Bold button to toggle the selection between bold and normal.

Press the Italic button to toggle the selection between italic and normal.

Alignment

Choose an alignment left, center, right, or full justification. This will affect the currently 
selected paragraph(s).

Paragraph

The Paragraph button provides a quick way to access the Paragraph command.
Letter Spacing (Kerning)
SmartSketch automatically takes advantage of any kerning information available in a font. 
See Keyboard Shortcuts for Editing Text for information on how to manually adjust the letter 
spacing.



Dropper Tool
Tools

The Dropper tool is used to pick up color and style information from the drawing so that you 
can draw with it or apply it to other parts of the drawing.

If you click the Dropper on a line, the dropper will activate the Pencil tool and copy the color,
thickness and dash pattern from the line you clicked to the current Pencil settings. The Pencil
will automatically be set to the Ink Bottle so that you can immediately apply the style to 
existing lines. If you want to draw a new line, simply deselect the Ink Bottle.

If you click the Dropper on a fill, the Brush tool will be activated and the color of the fill you 
clicked on will be copied to the current brush color. The Brush will automatically be set to the
Paint Bucket, so you can change the color of existing fills. If you want to draw a new brush 
stroke, simply de-activate the Paint Bucket.

If you click the Dropper on a text object, the font, size, and other settings of the text object 
will be copied to the current Text tool settings so you can create a new text object with 
exactly the same settings.
Note that the dropper cannot pick up information from the contents of a group object unless 
you are editing the object.



Magnifier Tool
Tools

The Magnifier tool is used to enlarge or reduce the the view of your drawing. Note that it 
does not actually change the drawing in any way, only your view of it.
Enlarging your view of the drawing allows you to see and edit the details. Reducing your 
view of the drawing provides an overview.
Click on any location in the drawing to enlarge or reduce your view.
If the Magnifier is set to enlarge, it will double the apparent size of the drawing and center 
the view on the location clicked.
If the Magnifier is set to reduce, it will reduce the apparent size of the drawing by half.
Pressing the Shift key will temporarily toggle between enlarge and reduce.
To zoom in on a specific area of your drawing, simply drag out a rectangle. The magnification
level of the view will be set so that the rectangle fills the window.
There is a maximum magnification that depends on the resolution of your monitor and the 
document size.
Modifiers

Set the magnifier to enlarge mode.

Set the magnifier to reduce mode.

See Also
Zoom commands
Zoom control



Lasso Tool
Tools

The Lasso tool is used to select odd-shaped portions of the drawing. Because you can 
specify any border for the area to select, the Lasso provides more control than dragging a 
selection rectangle with the Arrow tool.
To select an area, simply drag a loop around the area to select. It is best to end the loop 
approximately where you started, but if you don't, SmartSketch will automatically close the 
loop with a straight line.
Normally, the current selection will be deselected before the new selection is made, but if 
you press the Shift key, the area enclosed by the loop will be added to the current selection.
To deselect everything, simply click anywhere on the drawing.



SmartSketch Menus 
Reference Information

SmartSketch offers these menus:
File For working with documents and files.
Edit Edit the contents of the drawing.
View Change the way the drawing is displayed.
Format Format the document and drawing.
Tools Operate on the drawing.
Object Operate on floating objects in the drawing.
Window Activate and arrange windows.
Help Get help with SmartSketch.



Object Menu 
Menus

The Object menu offers these commands:
Create Group Create a new group object.
Break Apart Break apart the selected objects.
Edit Object Edit the selected object.
Edit Page Return to editing the entire page.
Move to Front Move the selected objects in front of the unselected objects.
Move to Back Move the selected objects behind the unselected objects.
Remove Transform Remove any scaling or rotation from the selected objects.
Lock Lock the selected objects so they cannot be accidentally modified.
Unlock All Unlock all of the objects on the page.



Break Apart Command 
Object Menu

This command breaks the selected objects into their component pieces.
If an object contains lines or fills, they will be merged into the drawing layer when they are 
deselected.
If a text object is selected, the text will be converted into editable fills. You will then have 
great flexibility to edit the text as reshapable curves but you will no longer be able to be edit
the text with the Text tool. Note that only outline fonts can be broken apart; any bitmap 
fonts in your text object will disappear. Also, if you do not have bold and/or italic versions of 
a particular font installed on your system, it will appear as normal style after a Break Apart 
command.
If an embedded object is selected, it will be converted into editable SmartSketch objects. You
will no longer be able to edit the object in it's original application. Also, any bitmaps in the 
object will disappear.

Shortcut: CTRL+K



Rotate Command 
Tools Menu

Rotate Button

This command puts the selection into rotate mode; eight round handles defining a rotation 
marquee appear around the selection.
Drag a corner handle to rotate the selection (if snapping is on, the corner handle snaps to 
even multiples of 15 degrees). Drag a middle handle to slant the selection, skewing it in one 
direction.
Note that you can add items to the rotation rectangle at any time simply by clicking on the 
items are to be included.



Tools Menu 
Menus

The Tools menu offers these commands:
Connect Lines Turn snap-to-grid and the automatic connection of lines on and off.
Scale Provide handles to stretch the selection.
Rotate Provide handles to rotate and slant the selection.
Scale by Percent Scale the selection by a percentage.
Smooth Smooth the lines of the selection.
Straighten Straighten the lines of the selection.
Remove Color Converts the selected lines and fills to black and white.
Flip Vertical Flip the selection so it appears upside down.
Flip Horizontal Flip left and right edges of the selection.
Rotate Left Rotate the selection 90 degrees to the left.
Rotate Right Rotate the selection 90 degrees to the right.
Assistant Adjust how SmartSketch helps you draw.



Colors Command 
Format Menu

Color Button

The Colors command is used to select a color for the current tool and to edit the 
SmartSketch color list.
To Select a New Color
Select a new color using the color picker on the right, then press the New button. If you 
select a new color and press OK without pressing New, the color will automatically be added 
to the end of the list for you.
See Creating Colors for more information on using the custom color picker to create new 
colors.
To Change an Existing Color
Click on the color to select it. Adjust the color with the color picker on the right, then press 
the Change button to set the color.
To Delete a Color
Simply click on the color in the color list to select it, then press the Delete button.

The Color List
SmartSketch maintains a list of all the colors that you have used. This list is displayed in the 
Color dialog box, and in each of the color choices for the tools. SmartSketch always 
remembers this list. If the list gets cluttered with old colors, simply use the Delete button to 
remove any unwanted colors.

Current Tool Colors
Note that the Pencil, Brush and Text tool each have their own current color. So when 
selecting a color for one of the tools, be sure to select that tool before selecting the Color 
command. Then SmartSketch will know which tool color to set.



Format Menu Commands 
Menu

The Format menu offers these commands:
Document Change the document settings.
Colors Edit SmartSketch's list of colors.
Font Change the current font.
Paragraph Change the current paragraph settings.
Align Align the selected parts of the drawing.
Add Page Add a new page.
Delete Page Delete the current page.
Rename Page Rename the current page.



Font Command 
Format Menu

The Font command provides access to the standard Windows dialog box for choosing a font. 
This is useful when you want to quickly preview a variety of fonts without changing your 
document.
If you press the OK button, the next time a text box is created with the text tool, 
SmartSketch will use the newly selected font. If text is selected when the OK button is 
pressed, the selected text will be changed to the new font.
See Also

Text Tool



Create Group Command
Object Menu

The Create Group command creates a new group object that floats above the lines and fills 
in the drawing layer.

Creating a Group from a Selection
If there is already a selection when the Create Group command is chosen, the entire 
selection will be put into a single new object. This is useful for making lines and fills or 
multiple objects into a single object so that they can be treated as a single entity and will 
not be connected to other lines and fills in your drawing. It is also the only way to make lines
and fills float above other objects, such as text and embedded objects.
Creating a New Empty Group
If there is no selection, a new empty object will be created and activated for editing. This 
creates a new layer in which you can draw on top of your drawing, without accidentally 
modifying existing parts of your drawing. This useful for tracing over or annotating a 
drawing.

Shortcut: CTRL+G
See Also

Break Apart command 
Edit Object command



Learning SmartSketch
Contents

The Introduction to SmartSketch lesson provides a basic overview of the benefits of using 
SmartSketch.

If you purchase the complete version of SmartSketch you will receive the eight on-screen 
lessons that are described below.

Quick Start
The Quick Start lesson is the fastest way to gain a basic understanding of SmartSketch. The 
on-screen exercises provide a "hands-on" introduction to the program.

Depth
Learn to create the illusion of depth by using techniques such as overlap, size & location, 
and color.

Fashion Designer
Learn how to use SmartSketch to explore fashion design. Use preexisting clothing pieces, 
and alter them to create your own clothing designs.

Headline Builder
Learn how to turn basic headlines into beautiful, creative works of art. The headlines can be 
used to add style to your word-processing pages, or used in SmartSketch to design a custom
piece. 
Home Designer
Learn techniques for using SmartSketch to create architectural drawings of your home. Use 
these skills to experiment with furniture arrangements, plan a remodeling project or design 
your dream home.

Logo Creator
Learn skills to create professional-looking logos and custom EasyArt in SmartSketch. You will 
be amazed at how easily you can edit EasyArt.

Map Maker
Learn the skills needed to quickly draw fun and professional-looking maps. Whether you 
need a map to direct customers to your business, or inform your friends and co-workers 
where an event is located, you can draw it easily in SmartSketch.
Technical Drawing
The Technical Drawing lesson shows how to apply SmartSketch to basic drafting problems. 
Includes discussions of isometric and orthogonal projections and the use of special purpose 
grids.



Getting Help in SmartSketch
Contents

Here are the best ways to get help while using SmartSketch:
Lessons
The best way get a basic understanding of SmartSketch is to work through the Quick Start 
Lesson. Other lessons teach specific drawing techniques. Refer to Learning SmartSketch for 
more information.

ToolTips and the Status Bar

The ToolTips and Status Bar provide a quick way to get short descriptions of the functions of 
the tool bar buttons and menu commands in SmartSketch. To use ToolTips, simply point to a 
toolbar button with the mouse and pause. A small window appears with the name of the 
button, and a brief description of the button appears in the Status Bar. A description of the 
currently selected menu command also appears in the Status Bar.

Help Button

The Help button provides more detailed information about SmartSketch's menu commands 
and buttons. Simply press the Help button to activate the Help mode, then click on any 
menu command, button or part of the SmartSketch window to open this help file to the page
that discusses that item. This is provides a way to use the on-line help as an interactive 
reference manual.
Reference Information

You can also use the on-line help more like a traditional book. Simply browse through the 
Reference Information just like you would a book. Remember that you can use the arrow (<<
and >>) buttons at the top of the screen to browse through related pages. The Search 
button at the top of the screen works just like the index in a book; you can enter a subject 
and instantly turn to any page that refers to that subject.



Scale Command 
Tools Menu

Scale Button (Arrow Tool)

The Scale command puts the selection into scale mode: eight square handles that define a 
scaling marquee appear around the selection.
Drag a handle to resize the selection: dragging any corner handle increases or decreases the
size of the selection while maintaining its proportions (i.e., its aspect ratio); dragging one of 
the middle handles scales the selection only vertically or only horizontally. You also can drag 
a handle across the rectangle to flip the selection while scaling.
If you scale a selection in one direction (horizontally or vertically) by dragging a middle 
handle, and then you scale the selection in the other direction (vertically or horizontally). 
The side of the scaling rectangle being moved snaps into place when the width and the 
height of the selection are the same.
Note that you can add items to the scaling rectangle at any time simply by tapping the 
items outside the marquee that are to be included.
See Also

Rotate command
Scale by Percent command



Straighten Command 
Tools Menu

Straighten Button

Choose this command to make the selected line segments a little more straight (the 
command has no effect on straight line segments). Repeatedly choosing this command 
makes each line segment straighter.
This command is also used to invoke shape recognition and make geometrically perfect any 
circles, ovals, rectangles, squares, triangles, and arcs drawn when the Assistant recognition 
options were off. Simply select the previously drawn items and choose Straighten 
Recognized shapes are redrawn correctly.
Note: A shape will not be recognized if it is touching (and thus is connected to) another 
item.



Reference Information
Contents

Basic Drawing Concepts
An overview of basic drawing concepts in SmartSketch.
Tools
A description of each of the SmartSketch tools.
Menus
Descriptions of the menu commands.
Keyboard Shortcuts
A summary of the keyboard shortcuts available in SmartSketch.
Using a Pen with SmartSketch
Tips on using SmartSketch with a pen input device.
Using SmartSketch with other Applications
Tips on integrating SmartSketch with other applications.
Answers to Common Questions
Tips on solving common problems you might encounter.
Working With Complex Drawings
Suggestions on how to use SmartSketch with very complex drawings.
Definitions
A list of terminology used in SmartSketch.
Installing and Removing Components of SmartSketch
How to modify your SmartSketch installation.
Printing Tips
Tips on how to deal with problems when printing a SmartSketch drawing.



Answers to Common Questions About SmartSketch
Reference Information

Here are 21 of the most common questions asked about SmartSketch. Scan this list before 
calling FutureWave Technical Support-- you may save yourself a phone call!
Each of the questions is followed by the word ANSWER. Click this word to see a complete 
answer to the question.
1. Why are Pencil lines, or Brush strokes, disappearing after I draw them? ANSWER
2. Why do things that I erase reappear? ANSWER
3. Why am I having difficulty selecting text or other objects with the Lasso tool? ANSWER
4. Why can’t I send text and other objects behind my lines and fills, and why can't I bring 

lines and fills in front of text? ANSWER
5. Why am I getting lots of line segments when I try to reshape? ANSWER
6. Why do I get strange colors along the edges of objects when I use the Smooth drawing 

mode? ANSWER
7. Why can't I zoom when editing a SmartSketch drawing in another application? 

ANSWER
8. Why does SmartSketch seem slow sometimes? ANSWER
9. How can I make additions to my drawing without the lines connecting or altering what 

I’ve drawn already? ANSWER
10. All or part of my page is gray and I can’t edit the items on it. What’s wrong? ANSWER
11. Why do my Brush strokes and Pencil lines change after I draw them? ANSWER
12. How can I keep shapes from snapping together when I reshape or move parts of my 

drawing? ANSWER
13. Why do the edges of text or objects look ragged or rough after using the Break Apart 

or Import commands? ANSWER
14. Why do the bitmaps in pictures disappear when I bring them into SmartSketch? 

ANSWER
15. Why does text disappear when I rotate it or break it apart? ANSWER
16. Why can't I change EasyArt that I dragged from the floating EasyArt book? ANSWER
17. Why can't I import a bitmap or a TIFF file into my drawing? ANSWER
18. How can I change the color and thickness of multiple lines in my drawing all at the 

same time? ANSWER
19. Why do parts of my drawing sometimes disappear when I zoom in to a very high 

magnification factor? ANSWER
20. Why does the text always print on top of the graphics in my drawing or not print at all 

with my HP or compatible printer? ANSWER
21. Why doesn't the size of my document change when I change the margins, orientation, 

or paper size with the Print Setup command? ANSWER



Technical Support
Contents

When You Have a Question
Tips on getting answers to questions about using SmartSketch.
Answers to Common Questions
A list of answers to common questions 
about SmartSketch.
Contacting FutureWave
Information on contacting FutureWave when you need
help finding an answer to a question.



Keyboard Shortcuts
Reference Information

Keyboard Shortcuts for Editing Text
Keyboard Shortcuts for Moving the Selection
Keyboard Shortcuts for Turning Pages
Keyboard Shortcuts to Switch Tools
Modifier Keys When Dragging



Keyboard Shortcuts for Editing Text
Keyboard Shortcuts

Moving the Insertion Point
Left Arrow Move one character to the left.
Right Arrow Move one character to the right.
Up Arrow Move one line up.
Down Arrow Move one line down.
Home Move to the beginning of the line.
End Move to the end of the line.
Control-Home Move to the beginning of the block.
Control-End Move to the end of the block.

Pressing the Shift key while using any of the movement keys will extend the selection.

Controlling Letter Spacing (Kerning)
Letter spacing can be manually controlled when a text block is being edited. Press the Shift 
key with the Control key to increase or decrease the letter spacing by 2 pixels instead of 1/2 
pixel. Kerning can either be applied to an entire selection or to the space between the 
characters surrounding the insertion point.

Control-Left Arrow Decrease the space between the selected characters by 1/2 pixel.
Control-Right Arrow Increase the space between the selected characters by 1/2 pixel.
Control-Up Arrow Reset the letter spacing to normal.



Keyboard Shortcuts for Turning Pages
Keyboard Shortcuts

Press the following keys to switch to a new drawing page (except when editing text):
Page Up Turn to previous page.
Page Down Turn to next page.
Home Turn to first page.
End Turn to last page.



When You Have a Question
Technical Support

There are a variety of ways you can get help with using SmartSketch. If you are just learning 
to use SmartSketch, we strongly recommend trying the Quick Start Lesson to help answer 
you basic questions. The on-line help is also an excellent place to find answers to any 
problems you may have.
The Answers to Common Questions section can also frequently help you.
If you cannot find an answer to your question in the materials provided with SmartSketch, 
see the Contacting FutureWave section for getting help directly from FutureWave.



Why Things Disappear
Answers to Common Questions

Q. Why are Pencil lines, or Brush strokes disappearing after I draw them?
A. There are two possible reasons.

If there are items on the object layer above where you are drawing, your Pencil lines 
and Brush strokes may not be visible because they are covered by the objects. Either 
draw in a different area, or choose the Create Group command to create a new group 
object that you can draw into and will float above other other objects in the drawing.
If you have the Brush Mode set to something other than Normal, your strokes may not 
be having an effect. Try setting the mode to Normal.



Contacting FutureWave
Technical Support

Technical support is available via e-mail, fax, or telephone for registered users of the 
complete version of SmartSketch. Unfortunately, we cannot provide free technical support to
users of this trial version of SmartSketch.
If you have a question that is preventing you from evaluating the trial version, or would 
additional information about SmartSketch, feel free to contact us.

FutureWave Software, Inc.
8305 Vickers Street, Suite 200
San Diego, CA 92111-2111

Telephone: 619-637-6190
FAX: 619-637-9032
E-Mail: 74654.1501@compuserve.com

Futurewav@aol.com



Document Command 
Format Menu

The Document command is used to change values that affect the current SmartSketch 
document.

Document Size
The document size controls the size of the imaginary piece of paper that you draw on. You 
can specify any size from 2" x 2" to 40"x40".
The Match Contents button will size your document so that it completely encloses the 
contents of every page of the document. 
The Match Printer button will size your document so that it fits exactly inside the paper size 
of the current printer, minus the space allocated for the margins.

Grid
Use the Show Grid button to show or hide the drawing grid. You can set a grid spacing by 
entering a value into the Spacing box.

Ruler Units
The ruler units pop-up selects the default units for this document. It affects both the display 
of the rulers, and how numbers in dialog boxes initially appear (e.g., document size and grid 
spacing). 
Note that the default Inches units use fraction subdivisions on the ruler (1/2, 1/4, 1/8, etc.) 
while Inches (decimal) use decimal fraction subdivisions (1/2, 1/5, 1/10, etc.).



Page Tabs Command 
View Menu

The Page Tabs command in the View menu is used to display or hide the Page Tabs on the 
left edge of the document window.
The Page Tabs shows all of the pages in the current document.
Click on a tab to turn to that page.
Double-click on a tab to rename the page.
Drag a tab into a new position to reorder the pages.
If there are more pages than can be displayed on the left edge of the window, scroll buttons 
will appear at the bottom of the page tabs to scroll up or down through the list of pages.
See Also

Keyboard Shortcuts for Turning Pages
Page Commands



Transform Commands 
Tools Menu

Flip Vertical
Flip the selection vertically on the page. In other words, the selection is flipped about its 
horizontal axis, so what was at the bottom of the selection is now at the top, and vice 
versa.

Flip Horizontal
Flip the selection horizontally on the page. In other words, the selection is flipped about 
its vertical axis, so what was at the left edge of the selection is now at the right, and vice
versa.

Rotate Left
Rotate the selection counterclockwise 90 degrees around the center point of the 
selection.

Rotate Right
Rotate the selection clockwise 90 degrees around the center point of the selection.

See Also
Rotate command
Scale command



Smooth Command 
Tools Menu

Smooth Button

Choose this command to smooth the curve of each selected line segment (the command has
no effect on straight line segments). Repeatedly choosing this command makes each 
segment smoother.
Smoothing is relative, depending on the segment. Generally, smoothing softens the curve, 
reducing bumps or other variations in its overall direction.
Use the Smooth command when you have trouble reshaping because there are lots of very 
small line segments.



Drawing Mode Commands 
View Menu

SmartSketch can draw your document in one of several different ways, to provide the 
appropriate solution for any given situation. You control these modes through the View 
menu.
Outlines

Draws only the outlines of the shapes in your drawing and all lines will be drawn as thin 
lines. This can make it easier to reshape your drawing and can be faster for complex 
drawings.

Normal
Draws all the colors and line styles of your drawing. This is the most common mode to 
work in.

Smooth
SmartSketch will draw the shapes and lines so that their edges appear smoother on the 
screen. This works best on video cards that provide thousands (16-bit) or millions (24-bit)
of colors. On 16 or 256 color video cards, black lines will be smoothed, but colors may 
look better in Normal mode. This mode will draw more slowly than the Normal mode.
Also note that SmartSketch does not smooth text or embedded objects in this mode, so 
these may make your drawing appear somewhat rough. If you do have these elements in
your drawing, you should keep them on the top of the stacking order.

Smooth Text
This works like Smooth except that SmartSketch will also smooth the edges of any text in
your drawing. This will work best with large font sizes and can be slow with large 
amounts of text.
Note that embedded objects cannot be smoothed.



Zoom Commands 
View Menu

These commands allow you to quickly change the apparent size of your drawing, much like 
the Magnifier tool.
Note that zooming is not possible when editing a SmartSketch object in another application.

Show Page
Set the zoom level so that you can see the entire drawing page in the window.

Show All
Set the zoom level so that you can see the entire contents of the current drawing page in
the window. If the page is empty, it will show the entire page.

100%
Set the zoom level to 100% so that your drawing appears as close as possible to actual 
size. Note that, depending upon your monitor and video card, one inch on the screen 
may not equal one inch on the SmartSketch rulers.



Assistant Command 
Tools Menu

This command opens the Assistant dialog box. The Assistant settings control how 
SmartSketch helps you draw by specifying tolerances for line smoothing, shape and line 
recognition, and snap-to options.
Each option can be off or on; turning on an option is accomplished by selecting a tolerance 
setting. These tolerance settings are relative, depending on the resolution of your computer 
screen and the current magnification of the page (as with drawing in general, zooming in 
provides better control). For each option, there are three tolerances: a normal setting, one 
that is more restrictive, and one that is less restrictive than normal. As a rule of thumb, the 
more restrictive setting is half as tolerant as the normal setting, while the less restrictive is 
twice as tolerant as normal. Some experimentation may be required to determine the 
settings that best suit the way you work.
Connect lines
This setting determines how close the end of a line being drawn must be to an existing line 
segment before the endpoint snaps to the nearest point on the other line. The available 
options are Off, Must be Close, Normal, and Can be Distant. 
This setting also controls horizontal and vertical line recognition: that is, how nearly 
horizontal or vertical a line must be drawn before SmartSketch will make it exactly horizontal
or vertical.

Snap to grid
This setting determines how close the end of a line being drawn must be to a grid line before
the endpoint snaps to the grid. The options are Off, Must be Close, Normal, and Can be 
Distant.
Smooth curves
This option specifies the amount of smoothing applied to curved lines drawn with the Pencil 
when the Pencil mode modifier is set to Straighten or Smooth. (Smoother curves are easier 
to reshape, while rougher curves match more closely the original line strokes.) The 
selections are Off, Rough, Normal, and Smooth.
Note that you can further smooth existing curved segments with the Smooth command.
Recognize lines
This option defines how nearly straight a line segment must be drawn before SmartSketch 
will recognize it and make it perfectly straight. The selections are Off, Strict, Normal, and 
Tolerant.
If Recognize lines is Off while you draw, line recognition can be performed later by selecting 
one or more line segments and choosing the Straighten command.
Recognize shapes
This setting controls how precisely you must draw circles, ovals, squares, rectangles, and 90-
degree and 180-degree arcs for them to be recognized as geometric shapes and redrawn 
accurately. The options are Off, Strict, Normal, and Tolerant.
If Recognize shapes is Off while you draw, shape recognition can be performed later by 
selecting one or more shapes (i.e., connected line segments) and choosing the Straighten 
command.

Tap accuracy
This setting specifies how close to an item you must tap before the tap is recognized as 



referring to the item. The options are Strict, Normal and Tolerant.



Edit Object Command 
Object Menu

The Edit Object command is used to edit a selected object. This command is only available if
a single object is selected.
If a group object is selected, you will be able to edit the contents of the group, and the rest 
of your drawing will become "grayed out" to indicate that it is inactive. To return to editing 
the entire drawing, choose the Edit Page command, or double click in an empty area of the 
drawing.
If a text object is selected, it will be activated for editing and the Text tool will be selected.
If an embedded or linked object is selected, it will be activated for editing.

Shortcut: Double-click on the object



Move to Front Command
Object Menu

The Move to Front command moves the selected objects in front of other objects in the 
stacking order of the object layer. Note that lines and fills cannot be moved out of the 
drawing layer unless they are in a group object.

Shortcut: CTRL+F



Move to Back Command
Object Menu

This command moves the selected objects behind all other objects in the stacking order of 
the object layer.
To move lines or fills on the drawing layer forward or backward, you must first put them into 
a group object with the Create Group command.

Shortcut: CTRL+B



Drawing Layout on the Printer

Since a single SmartSketch drawing page can be larger or smaller than a single printer page 
SmartSketch must arrange your drawing so that it fits onto printer pages.
The size option in the Document command dialog box determines the dimensions of the 
imaginary piece of paper that you are drawing on. The Print Setup command controls how 
this drawing is arranged on the actual printer paper.
The Print Setup command gives you tremendous flexibility in arranging your document on 
the printer paper. However, there are a few common situations that cover most needs. Note 
that SmartSketch always prints within the margins you specify, so the paper area you must 
work within when printing is the paper size minus the margins. 

If your drawing is smaller than the printer paper
SmartSketch's default setting prints your drawing at actual size by specifying a 100% scale. 
You can control the relative position on the page with the margins options in the Print Setup 
command dialog box.
Another common solution is to choose the "Fit on one page option" with the Print Setup 
command to have SmartSketch enlarge the printed size of your drawing so that it fills a 
printer page.
If your drawing is larger than the printer paper
By default, SmartSketch will print your drawing at actual size on multiple sheets of paper. 
This is known as tiling. After the pages are printed, you can join them together with tape and
scissors to create a single large drawing or a banner.
If you just want to see what your drawing looks like and do not want to use multiple sheets 
of paper, choose the "Fit on one page option" with the Print Setup command to have 
SmartSketch reduce the printed size of your drawing to fit on a single printer page.

Use Print Preview
Use the Print Preview command to preview how you drawing will be arranged on the printer 
paper. This avoids wasting paper.



Definitions
Reference Information

Click on any term for a definition.
-C-
click
Clipboard
corner
-D-
drag
double-click
document
drawing
drawing layer
-E-
embedded object
-F-
fill 
-G-
grid
group object
-H-
hairline
handle
hue
-K-
kerning
-L-
line
linked object
luminosity
-O-
object
object layer
-P-
page
page tabs
point
-R-
rulers
-S-



saturation
selection
snapping
stacking order
-T-
text object
tiling



Corner
A corner is a location where a line has a sharp edge, or where three or more lines intersect.



Basic Drawing Concepts
Reference Information

There are several basic concepts that are important to understand when using SmartSketch:
Lines and Fills
The most basic elements of SmartSketch drawings are lines and fills. Lines are created with 
the Pencil and can have a variety of styles, but are always a constant thickness and fairly 
thin. Lines are very easy to reshape.
Fills are enclosed areas of color created with the Brush. They can surround any shape area, 
and usually require more effort to reshape than lines since they have edges on all sides, 
instead of just a single line.
Click below to see which are lines and which are fills.

When in SmartSketch, you can try the Outlines command from the View menu to see how 
lines are different from fills.
Automatic Connection of Lines and Fills
This is one of the most powerful features of SmartSketch: Whenever you draw a new line 
with the Pencil or a fill with the Brush, it is automatically "connected" to any lines or fills that
it touches. The connection of lines doesn't have an effect when you first create your 
drawing, but you will need to be aware of it when you reshape and move parts of your 
drawing.
The connection of lines is useful because you can immediately tell just by looking at your 
drawing how it can be reshaped. It also allows SmartSketch to implement powerful tools like 
the Eraser and Lasso, which are not available in other precision drawing applications.

Drawing and Object Layer
All lines and fills are drawn into the drawing layer. Because they are connected as they are 
drawn, there is no front-to-back stacking order in the drawing layer--this is unlike traditional 
drawing applications.
The object layer is above the drawing layer and consists of individual objects that do have a 
front-to-back stacking order. Objects in SmartSketch can be text objects, embedded objects, 
and group objects. Objects are never affected by tools such as the Pencil, Brush or Eraser.
If you want to protect a portion of the drawing layer from being connected, or if you want to 
draw something in front of an object, use the Create Group command to convert the 
selection into a single group object.
If you want to make an object part of the drawing layer, use the Break Apart command.
Note that when you move part of your drawing, SmartSketch will automatically float the 
lines and fills above the drawing layer so that they will not be connected to other lines and 
fills until they are deselected. This allows you to easily adjust the position of the selection 
before choosing a final location.

Selection



Selecting a portion of your drawing is a way of telling SmartSketch to affect only that 
portion. For example if you want to move or rotate part of your drawing, you must select it 
first. SmartSketch indicates selection in the drawing layer by drawing the selected objects 
with a textured pattern. Selected objects are indicated by a textured rectangle drawn around
the object. See Selecting Parts of the Drawing for more information.

Zooming In
SmartSketch edits and prints your drawing at a very high resolution. However, computer 
monitors can only display your drawing at a relatively low resolution. To create, see and edit 
the fine details of your drawing, you must zoom in to magnify your view of the drawing. Any 
time you want more precise control over your drawing, simply use the Magnifier to zoom in 
on the area of interest.



Using Snapping

SmartSketch helps you draw polished drawings by automatically aligning corners, lines, and 
objects when dragging and reshaping.
SmartSketch indicates that is is looking for snap possibilities by drawing a small circle on the
location that it is interested in. When something is found to snap to, SmartSketch precisely 
aligns the point and draws a heavy circle instead of the light circle.
Snapping tolerances can be adjusted using the Assistant command. Snapping can be quickly
enabled or disabled by using the Snap command or by pressing the Shift key while dragging.
If Snap is on and the Shift key is pressed, it will be turned off. If it is off and the Shift key is 
pressed, it will be turned on.
If you want SmartSketch to look for snap points when dragging, it is important to click on a 
corner point when starting to drag. It you drag a line by a smooth point, SmartSketch will not
have a reference point and will not snap to anything.

See Also
Align command



Adobe Illustrator File Format (.EPS, .AI)

The Adobe Illustrator file format is ideal for exchanging drawings between SmartSketch and 
other drawing applications. This format provides very accurate conversion of curve, line 
style and fill information. (SmartSketch fully supports the Adobe Illustrator 1.1 format. With 
later versions of the format, portions of your drawing may disappear during import.)
Note that not all EPS files are in the Adobe Illustrator format. For example, SmartSketch 
cannot import EPS files generated through the Windows Print command.
Drawings exported in this format will not contain any embedded objects. If you want to 
export embedded objects, use the Break Apart command on any embedded objects before 
performing the export.
Images exported in the Adobe Illustrator 1.1 format can be placed in any application that 
supports EPS import (e.g. Aldus PageMaker and QuarkXPress). 
Note that EPS files exported from SmartSketch do not include preview pictures, so when 
placed in another application, they will be displayed as an empty rectangle, but will print 
correctly on a PostScript printer. Also, the fonts used for text in your drawing may be 
modified during import and export since PostScript fonts do not match Windows fonts.
See Working with EPS files for more information.



AutoCAD DXF File Format (.DXF)

Most computer-aided design (CAD) applications support this format.
DXF files do not support the standard Windows fonts. SmartSketch will attempt to map fonts 
appropriately, but the results, particularly the alignment of text, can be unpredictable. 
Since the DXF format does not support solid fills, filled areas are exported as outlines only. 
For this reason, the DXF format is most appropriate for line drawings, such as floor plans and
maps.
Drawings exported in this format will not contain any embedded objects. If you want to 
export embedded objects, use the Break Apart command on any embedded objects before 
performing the export.
Typical two-dimensional DXF files will be imported with excellent results (SmartSketch will 
not import three-dimensional DXF files). However, SmartSketch does not support multiple 
layers--all layered objects will appear in SmartSketch’s drawing layer. Also, pattern fills are 
imported as lines; with dense fills, this can result in a very large document that slows 
SmartSketch considerably.
SmartSketch does not support scaling in a DXF file. All imported DXF files will produce 12-
inch by 12-inch documents that can then be scaled with the Scale command. Also, 
SmartSketch supports only ASCII DXF files; if your DXF files are binary, they must be 
converted to ASCII before importing into SmartSketch.



A selected fill is drawn with a small "checker board" texture.



A selected line is drawn with an angled texture.



A selected object is drawn with a texture box surrounding it. Examples of objects include 
text, embedded objects, and group objects.



Reshaping Lines

Frequently, you want to move a line in your drawing. This is done by reshaping with the 
Arrow tool. To reshape a line, simply point to the line with the arrow, press the mouse button,
and drag the mouse without releasing the button. When the line is positioned properly, 
release the button. Remember, if you don't like your change, choose the Undo command.
Note that if a line is selected, you will move the entire line instead of reshaping it. So be sure
to deselect the line before reshaping it.

Grabbing Corners or Lines
Also note that there is a difference between "grabbing" a line on a corner or on a smooth 
portion of a line. Grabbing a corner as shown below causes the lines at the corner to remain 
straight.

Grabbing on the straight or smooth portion of a line as shown below causes the curvature of 
the line to change as you drag.

Automatic Connection
It is important to be aware that any time lines touch or cross over when reshaping, they will 
be connected. See Connecting Lines for more information.

Smooth Before Reshaping
Lines created with the Ink mode of the Pencil or with the Brush frequently have too much 
detail to reshape easily. If you are having trouble reshaping a line, select the line and choose
the Smooth command to remove some of the unwanted details in the line and make 
reshaping easier.

Snapping
If you reshape a corner while snapping is turned on, SmartSketch will snap the corner to 
other portions of your drawing. See Snapping for more information. Note that it does not 
make sense for SmartSketch to snap when you grab the smooth portion of a line.



Moving Parts of the Drawing

To move part of your drawing, simply select the portion you want to move, press anywhere 
on the selection with the Arrow tool, and drag the mouse.
Copying While Dragging
If the Control key is pressed when the mouse is released, SmartSketch will create a copy of 
the selection at the new location and leave the original unchanged.
Snapping
If you click on a corner in your drawing while snapping is turned on, SmartSketch draws a 
small circle at the point you clicked on and snaps that point to the grid and to other lines in 
your drawing as you drag.

Drag and Drop Between Windows
If you drag outside of the SmartSketch window, SmartSketch will allow you to move or copy 
the selection to another SmartSketch window or to another application that is visible on the 
screen.
Nudge Keys
To move the selection by a very small amount at a time, you can use the four keyboard 
arrow keys. Pressing any of the arrow keys will move the selection a small distance in that 
direction. Pressing an arrow key while pressing the Control key will move the selection a 
larger distance.



Click
To click, use the mouse to position the pointer at the desired location, then press the left 
mouse button and release it quickly without moving the mouse while the button is down.



Zoom Control (Standard Toolbar)

The Zoom Control shows the current zoom level and allows you to pick a new zoom level. 
You can type a new zoom factor into the edit box, or you can use the menu to quickly choose
one of the default zoom factors. If you are zooming in on your document, SmartSketch will 
center the selection in the window.
The Show Page option makes your entire page visible in the window. The Show All option 
makes the entire contents of the page visible in the window.
There is a maximum magnification that depends on the resolution of your monitor and the 
document size.
See Also

Magnifier tool
Zoom commands



Double-click
To double-click, point at the location you want to click with the mouse, then quickly press 
and release the left mouse button twice without moving the mouse.



Drag
To drag an object, use the mouse to point at the location you want to drag, then press the 
mouse button and hold it down. Drag with the mouse to move the object to the desired new 
location, then release the mouse button.



Using a Pen with SmartSketch
Reference Information

Because drawing with a pen is such as natural activity, SmartSketch was designed to work 
very well with any pen-based input device supported by the Windows environment.
All of SmartSketch's tools work with a pen. Many users get much better results with the 
Brush and the Pencil when using a pen. If your pen system supports handwriting recognition,
you can write into any SmartSketch dialog box and the Text tool will support all of the 
standard editing gestures.
If you have a pressure-sensitive pen, a new icon will appear in the Brush tool modifiers. This 
allows the thickness of strokes made with the Brush to vary, depending on the pressure. This
can quickly produce some powerful effects.
Generally, drawing with a pen input device in SmartSketch is just like using a mouse, except 
that you will have more control over your strokes.

Tap Accuracy
With some pen input devices, it can be difficult to click on small points. If you frequently 
miss when clicking on lines or handles in SmartSketch, try using the Assistant command to 
set the tap accuracy to Tolerant. This is most helpful for pen computers where you write 
directly on the display, or for light pens that work on the computer monitor.

Brush Tool

If you have a pressure-sensitive pen, a pressure icon will appear with the Brush tool 
modifiers. If this icon is selected, the thickness of your brush stroke will range from tiny (with
little pressure) to the maximum size selected (with heavy pressure). If the icon is up, the 
brush will work just like it does with a mouse.
Text Tool
If you have a pen with handwriting-recognition support, the Text tool will allow you to write 
directly into the drawing window and translate your writing into text. To create an empty text
box to write into, either click for a small box, or press and pause before moving the pen to 
drag out a text box.
The Text tool supports all of the standard editing gestures.



Hairline
A hairline is the thinnest possible line that SmartSketch can draw on a given device. A 
hairline is always one pixel wide on the screen but will appear thinner on high-resolution 
output devices like laser printers.



Shapes Recognized by SmartSketch

Here are examples of the types of shapes that SmartSketch will recognize. Click on the 
shapes to see detailed descriptions.

Shape recognition can be adjusted with the Recognize Lines and Recognize Shapes options 
in the Assistant command.



Point
A point is a unit of measurement frequently used by printers. It is equal to 1/72 of an inch. 
SmartSketch uses points for line thickness and font sizes.



Oval
SmartSketch will recognize any oval as long as it is drawn with a single stroke. If the oval is 
almost a circle, SmartSketch will make it an exact circle.



Rectangle
SmartSketch will recognize any rectangle drawn with a single stroke. If the height is almost 
the same as the width, SmartSketch will make it a perfect square.



Straight Line
SmartSketch will recognize straight lines. When drawing straight lines, be sure to make the 
corners very distinct. Also, SmartSketch will recognize when a line is vertical or horizontal.



Arc
SmartSketch will recognize 90-degree and 180-degree arcs. When drawing a 90 degree arc, 
be sure to draw a distinct curve; otherwise SmartSketch will interpret it as a straight line. 
Note that arcs must be drawn in a single stroke and that the axes must be vertical and 
horizontal for the arcs to be recognized.



Using SmartSketch with other Applications
Reference Information

Frequently, you will want to incorporate your SmartSketch drawings into other applications 
such as your word-processing or presentation package, or you may want to incorporate 
graphics from another application into your SmartSketch drawing.
The Clipboard
One of the easiest ways to copy data between applications is to simply choose the Copy 
command in one application and then choose the Paste command in another application. 
This can be used to move graphics and text both into and out of SmartSketch.
An important requirement for using the Copy and Paste operation is that both applications 
must agree on a format that both understand. This may be a problem with older bitmap-
editing applications. SmartSketch does not understand bitmaps directly, but it will display 
bitmaps if your bitmap application supports creating embedded objects.
Drag and Drop
Drag and drop is a convenient shortcut to Copy and Paste. Simply make a selection in 
SmartSketch and drag it into another application's window. This will work with most 
applications, but some older applications do not yet support drag and drop. If drag and drop 
does not work, try Copy and Paste. See the Arrow tool for more information.
Editing SmartSketch Drawings in Other Applications
Many newer applications such as Microsoft Word 6.0 or Microsoft Excel 5.0 support in-place 
editing. This allows you to edit a SmartSketch drawing without leaving your word processor, 
spreadsheet, or other application. When you double-click on a SmartSketch object that you 
have placed in another application, SmartSketch's menus and tools will appear and you will 
be able to edit you drawing. 
Because SmartSketch must work within the limitations of the application that contains the 
SmartSketch object, you cannot use the Magnifier tool or Zoom Control. Also, you cannot 
access SmartSketch commands in the File menu such as Open as EasyArt, Import and 
Export. If you need to use any of these features, you can use the Open command instead of 
double-clicking on the SmartSketch object. The Open command can normally be found in the
Edit menu under Object when the SmartSketch object is selected in your word processor or 
other application..
Import and Export
The Import and Export commands are used when you want to transfer an entire drawing into
or out of SmartSketch. One of its most common uses is to bring clip art or drawings from 
your old drawing application into SmartSketch. See the Import and Export commands for 
more information.



Disappearing when Zooming
Answers to Common Questions

Q: Why do parts of my drawing sometimes disappear when I zoom in to a very high 
magnification factor?

A: Because Windows is a 16-bit operating system, it has difficulty dealing with numbers 
greater than 32000. This can occasionally cause a problem when zooming in on your 
drawing to a magnification greater than several hundred percent. In particular, 
Windows may have trouble drawing embedded objects. This does not damage your 
drawing; it simply means you need to work with your drawing at a lower magnification 
level.



Working with EPS Files

Encapsulated PostScript (EPS) files provide a powerful way to exchange high-quality graphics
information between applications. Unfortunately, the EPS file format can sometimes be 
complex and confusing to work with.
There are several ways to create and use EPS files in SmartSketch.

Exchanging Editable Drawings
The Adobe Illustrator 1.1 file format is a specific type of EPS file that typically has an .AI 
or .EPS file extension. It is used for exchanging editable drawings. You can bring Adobe 
Illustrator EPS files into SmartSketch with the Import command, then use all of 
SmartSketch's tools to edit the drawing after breaking it apart. Use the Export command to 
create Adobe Illustrator EPS files that you can bring into many other drawing applications for
editing.
Most EPS clip art that you might purchase is stored in the Adobe Illustrator 1.1 format, and 
can be imported into SmartSketch with the Import command.
The major limitations of the Adobe Illustrator 1.1 file format are that it will not preserve your 
font selections, and any embedded objects will not be saved.

Creating EPS Files for Output
If you need to output your SmartSketch drawing on a high-end PostScript printer or 
imagesetter, use the Windows PostScript driver to create an EPS file. Unlike an Adobe 
Illustrator EPS file, this EPS file will contain all the fonts needed to print your drawing.

1. Install the proper printer driver for the PostScript printer that you plan to output to. 
Note that you can install a printer even though it is not physically connected to your 
computer. You will of course not be able to print directly to the printer, but you can 
use the driver to create printer files.

2. Choose the Print Setup command in SmartSketch and select the desired printer.
3. Choose the Options button in the Print Setup dialog box and choose to generate an 

EPS file.
4. Click OK to exit the Options and Print Setup dialog box(es).
5. Arrange your document to print properly. Your drawing must print on a single printer 

page. Also, the bounds of the EPS file will match the document size. To adjust this 
size , use the Document command to resize your document, then position your 
drawing within the document.

6. Choose the SmartSketch Print command; SmartSketch will generate the EPS file with 
the name you specified in the Options dialog.

You can then place this EPS file in any application that will print an EPS file. The file will be 
displayed on the screen as an empty box but it will print properly on a PostScript printer.
EPS files created with your printer driver can be printed from other applications, but unlike 
the Adobe Illustrator EPS files, they cannot be modified in a drawing application.
Color Separations
Color separations are needed if you want to have a professional printer print color versions 
of your SmartSketch drawings. Although, SmartSketch does not support color separations 
directly, many high-end page layout and drawing applications can generate 4-color 
separations from a SmartSketch EPS file. Simply create an EPS file with the PostScript printer
driver as described above and follow the instructions provided with your layout application 
to import and print your color separations.
Also, many service bureaus can generate 4-color separations directly from an EPS file that 



you provide them. Be sure to ask them for details about which printer driver and setting to 
use when generating the EPS file from SmartSketch.



Rulers
The Rulers can be shown on the top and left edge of the drawing window, and are used to 
measure distances in the drawing. See the Rulers command for details.



Line
This is a line created with the Pencil.



Fill
This is a fill created with the brush.



Line and Fill
This is black line that encloses a blue-filled area.



Line
A line in SmartSketch is any straight or curved line created by the Pencil tool. Lines have a 
thickness, color, and dash pattern.
Here are some examples of lines:



Fill
A fill in SmartSketch is any enclosed colored area. 
Here are some examples of fills:



Drawing Layer
All lines and fills are created and edited in the drawing layer. The Brush, Pencil and Eraser 
work only in the drawing layer. When selected, lines and fills in the drawing layer are drawn 
with a textured pattern.



Document
A SmartSketch document is contained in a single file with the .SSK extension. A single 
document can consist of multiple pages of drawings.



Object Layer
The object layer has a front-to-back stacking order and contains all objects. Objects include: 
text objects, embedded objects, and group objects. Objects are drawn with a textured 
rectangle surrounding them when they are selected.



Drawing
Your SmartSketch drawing consists of all the lines, fills and objects that you can see on a 
single page of a document.



Linked Object
A SmartSketch object that has been created in another application and is contained in a 
separate file. The object in SmartSketch will be updated whenever the original file changes.



Embedded object
An object created in another application that is embedded in a SmartSketch file. You can use
the originating application to edit the object in SmartSketch by choosing the Edit Object 
command.



Group Object
A group object is a SmartSketch object in the object layer that contains a collection of lines, 
fills, and/or other objects, and is treated as a single object.
Use the Create Group command to create group objects, and the Edit Object command to 
edit the contents of a group object.



Text Object
A text object contains formatted text that was created and can be edited with the Text tool.



Object
An object is contained in the object layer of a drawing and is treated as a single entity. It can
be edited and broken apart. Objects also have a stacking order within the object layer, and 
can be moved in front of or behind other objects.
When objects are selected, they are drawn with a textured rectangle surrounding them.



Page
A SmartSketch document can be made up of several pages. Pages are accessed through the 
page tabs.



Page Tabs
The page tabs are used to select and reorder the pages in a SmartSketch document. To turn 
to a new page in a document, simply click on the appropriate tab. The page tabs can be 
displayed on the right edge of the document window with the Page Tabs command.



Stacking Order
The stacking order is the front-to-back arrangement of objects in the object layer. The 
objects in front or on top obscure the objects behind them, just like sheets of paper on a 
desk.
Note that the drawing layer does not have a stacking order.



Snapping
Snapping is the automatic alignment of corners, lines or objects to other corners, lines or 
objects. SmartSketch draws a small circle when it is looking for something to snap to and it 
draws a heavy circle when it has found something to snap to.
You can enable or disable snapping with the Snap command, or by pressing the Shift key.



Selection
The selection indicates to SmartSketch what portion of the drawing to operate on. Selected 
lines and fills are indicated by drawing them with a textured pattern. Selected objects are 
indicated by surrounding them with a textured rectangle.



Keyboard Shortcuts for Moving the Selection
Keyboard Shortcuts

Use these keys to precisely move the selection small distances:
Left Arrow Move the selection left one pixel.
Right Arrow Move the selection right one pixel.
Up Arrow Move the selection up one pixel.
Down Arrow Move the selection down one pixel.

Press the Shift key when nudging to move eight pixels at time instead of one pixel.



Modifier Keys When Dragging
Keyboard Shortcuts

Shift Press the Shift key to toggle snapping on or off.
Control Press the Control key to duplicate the selection when dragging.



Keyboard Shortcuts to Switch Tools
Keyboard Shortcuts

Pressing the following keys anytime (except when editing text) provides a quick way to 
switch between tools:

Key Tool
A Arrow
P Pencil
B Brush
E Eraser
T Text
D Dropper
M Magnifier
L Lasso

Pressing the Spacebar temporarily switches to the Arrow tool.



ToolTips

The ToolTips are the small yellow windows that appear when the mouse pointer pauses over 
one the buttons in the tool bars. They provide a quick way to get a short description of the 
functions of the various buttons.
To display the ToolTips, simply move the mouse over any button and pause. After a moment, 
a small window will appear with the name of the button. In the status line at the bottom of 
the SmartSketch window you will see a very brief description of the function of the tool.
If you want more detailed information, click the Help button to active the help mode, then 
click on the button you are interested in.



Why Things Reappear After Erase
Answers to Common Questions

Q. Why do things that I erase reappear?
A. Only items on the drawing layer can be erased; objects on the object layer cannot be 

erased. Thus, when the SmartSketch finishes processing your eraser strokes, text and 
groups reappear. If you need to erase portions of an object, select the object and 
choose either the Edit Object or Break Apart command.
Another possibility is that the Erase Mode is set to something other than Normal. Try 
setting it to Normal and erasing.



Why Do I Get Lots of Lines?
Answers to Common Questions

Q: Why am I getting lots of line segments when I try to reshape?
A: Any time that lines touch or cross in the drawing layer, SmartSketch will connect and 

segment them, which provides great flexibility. For example, you can select a line 
segment and delete only that segment. With this approach to drawing you should think
of line strokes as items intersecting on a single layer, rather than as being separate 
items that are layered on top of one another. If you have difficulty, it is best to either 
undo the operation that caused the problem, or erase the lines and redraw them 
correctly.
If a curve looks smooth and does not cross any other lines, but you still get many short
lines when you reshape, you can select the line(s) and choose the Smooth command to
convert the small line segments to a smooth curve.



How Can I Draw on Top
Answers to Common Questions

Q: How can I make additions to my drawing without the lines connecting or altering what 
I’ve drawn already?

A: Choose the Create Group command to create a new group object (like a transparent 
layer) on top of all everything else in your drawing. You can use all the tools to draw 
into this group without affecting anything else on the page. Choose the Edit Page 
command when you are done. To edit these additions later, use the Edit Object 
command.



Why is My Drawing Grayed Out?
Answers to Common Questions

Q. All or part of my page is gray and I can’t edit the items on it. What’s wrong?
A. Existing items that are not part of the selected group are dimmed and unavailable 

when you choose the Edit Object or Create Group commands. To exit group-editing 
mode, choose the Edit Page command.



Why Lines Change
Answers to Common Questions

Q. Why do my Brush strokes and Pencil lines change after I draw them?
A. The modifiers for the Brush and Pencil tools affect how SmartSketch processes your 

strokes. For the Pencil, if you don’t want SmartSketch to smooth and straighten your 
strokes, choose Ink from the Pencil Mode menu. For the Brush, be sure the Fill Mode 
modifier is set to Normal.



Controlling Snapping
Answers to Common Questions

Q. How can I keep lines and shapes from snapping together when I reshape or move parts
of my drawing?

A. There are several ways to achieve more control over SmartSketch’s snapping feature 
(snapping to an item or grid line is indicated by a dark circle at the mouse pointer). 
Frequently, the best approach is use the Magnifier to zoom in on the portion of the 
page you are working on, so you can move things more precisely. Also, when moving a 
selection, it helps to grab the selection away from any corners or endpoints. You can 
turn on or off snapping with the Snap command. In addition, you can turn off the grid 
(from the Document command) to disable grid snap, or you can adjust the snap-to 
settings with the Assistant command.
Also, you can temporarily disable (or enable) snapping by pressing the Shift key.



Selecting Objects with the Lasso
Answers to Common Questions

Q. Why am I having difficulty selecting text or other objects with the Lasso tool?
A. When selecting objects with the Lasso, it is important to completely enclose the object 

with the loop drawn. With text objects, you must completely enclose the rectangle that
appears when the text is selected.



Where's my Magnifier?
Answers to Common Questions

Q: Why can't I zoom when editing a SmartSketch drawing in another application?
A: When editing a SmartSketch drawing in another application, the other application is 

responsible for zooming. This means that you cannot access SmartSketch's zoom 
commands or the Magnifier tool.
If you want to use SmartSketch's zooming abilities, use the Open command instead of 
the Edit command. In most applications, these commands can be found in the Edit 
menu under Object.



Moving Lines and Fills to the Object Layer
Answers to Common Questions

Q: Why can’t I send text and other objects behind my lines and fills, and why can't I bring 
lines and fills in front of text?

A: Lines and fills are created in the drawing layer, while text is created in the object layer,
which is above the drawing layer. If you want to gain complete control over the 
stacking order of lines and fills, you must move them to the object layer with the 
Create Group command.



Why SmartSketch Seems Slow
Answers to Common Questions

Q: Why does SmartSketch seem slow sometimes?
A: SmartSketch does a lot of work behind the scenes to keep track of all of the lines and 

fills in your drawing. In particular, since SmartSketch automatically connects all of your
lines and fills, it must do more work than other drawing applications in some 
situations. The benefit of this extra work is that SmartSketch can support powerful but 
easy-to-use tools like the Brush, Eraser, and Lasso. Also, the draw Smooth command in
the View menu can produce a very high-quality display of your drawing, but takes 
extra processing.
Refer to the section Working with Complex Drawings for tips on how to help 
SmartSketch work more quickly.



Working with Complex Drawings
Reference Information

Just like any graphics application, working with very complex drawings in SmartSketch can 
become slow. Here are a few tips to help you avoid doing things that will make SmartSketch 
unnecessarily slow:
Tips

1. Set view to Outlines or Normal.
2. Segment your drawings into logical group objects.
3. Set the Brush Paint Bucket to Don't Close Gaps.

Redrawing the Screen
The Smooth and Smooth Text Draw Mode commands in the View menu tend to be much 
slower than Normal and Outlines. When editing your drawing, work with Normal or Outlines 
and only use the smooth options to preview your work.
If your drawing is extremely complex, you might try drawing it in several logical pieces and 
then assemble those pieces into your final drawing.

Connecting Lines
Whenever SmartSketch needs to put lines or fills into the drawing layer, it must look at all of 
the lines to see where they intersect, and it must examine all of the fills to eliminate any 
portions that overlap. This typically happens when you deselect after dragging part of your 
drawing, or when you choose the Break Apart command.
Also, when beginning to drag lines or fills in your drawing, SmartSketch must temporarily 
float these above the drawing layer. This can take a few moments.
You can reduce the amount of work SmartSketch does when connecting lines by segmenting 
your drawing into objects with the Create Group command. Since SmartSketch does not 
connect the lines in separate objects, this can save a lot of work.
Closing Gaps when Filling with the Brush Paint Bucket
When filling an area with the Brush Paint Bucket, SmartSketch finds and closes any small 
gaps between the lines in your drawing. Since SmartSketch will only look for gaps in the 
visible portion of the window, you can speed up this process by zooming in on the specific 
portion of the drawing you want to fill. Also, you can close any gaps manually and use the 
Don't Close Gaps option of the Paint Bucket to keep SmartSketch from spending any time 
looking for gaps to close.



Why the Strange Colors with Draw Smooth?
Answers to Common Questions

Q: Why do I get strange colors along the edges of objects when I use the Smooth drawing 
mode?

A: Draw Smooth is designed to work best with video displays that support thousands (16-
bit) or millions (24-bit) of colors. If your display is set to only 16 (4-bit) or 256 (8-bit) 
colors, Draw Smooth may not work well with some colors.
Note that even if your display only supports 16 or 256 colors, Draw Smooth will be able
to smooth black lines, but colored lines may have speckled edges.



Why Do Bitmaps Disappear?
Answers to Common Questions

Q: Why do the bitmaps in pictures disappear when I bring them into SmartSketch?
A: SmartSketch does not directly support bitmaps. If you want to work with bitmaps in 

SmartSketch, you must use a bitmap-editing application that supports embedding 
objects. See Working with Bitmaps for more information.



Why Does Rotated Text Disappear?
Answers to Common Questions

Q: Why does text disappear when I rotate it or break it apart?
A: SmartSketch can only rotate and break apart text that uses outline fonts. If you use a 

bitmap font, it will disappear. Note that SmartSketch fully supports both the TrueType 
fonts that are standard with Microsoft Windows 3.1, and PostScript style fonts if you 
have Adobe Type Manager.



Why are Objects Rough After Break Apart?
Answers to Common Questions

Q: Why do the edges of text or objects look ragged or rough after using the Break Apart 
command?

A: SmartSketch drawings are based on curves, while most imported graphics are based 
on polygons that make curves of many small line segments. The conversion of 
polygons to curves can introduce errors into your drawing. One way to minimize these 
errors is to enlarge an object with the Scale command before breaking it apart, then 
shrink it back down to the desired size after breaking it apart.



Unlock All Command
Object Menu

The Unlock All command is used to make the locked objects in a drawing editable again. 
When you choose this command, all locked objects in the document are unlocked and 
selected.
Note that since it is not possible to select a locked object, there is no way to unlock just one 
of the locked objects in a drawing. If you want to unlock just one, a useful tip is to choose 
the Unlock All command, deselect the object(s) you want to unlock by Shift-clicking on it, 
then choose the Lock command so the still-selected objects will be locked again.

See Also
Lock command



Lock Command
Object Menu

The Lock command is used to protect objects in the drawing from being modified. A locked 
object cannot be selected or changed. To lock and object, simply select the object and 
choose the Lock command.
The Lock command is unavailable if there are no objects selected. Note that if your want to 
lock part of the drawing layer, you must first use the Create Group command.
To unlock all of the locked objects use the Unlock All command.



EasyArt Book

The EasyArt book floats above your drawings and provides a quick way to drag and drop 
individual images from SmartSketch's EasyArt library into your drawings.
Use the Open as EasyArt command or EasyArt Finder to open an EasyArt book.
Dragging EasyArt

Once an EasyArt book is open, simply drag an object from the window into your drawing, or 
into another application that supports drag and drop. The mouse pointer will indicate with 
arrows in the lower right when it is over an object that can be dragged out of the window. 
Note that some elements in the window are simply decorative or informational and cannot 
be dragged out.
Many EasyArt books have multiple pages; to turn to another page, simply use the page tabs 
on the right edge of the window. Note that the EasyArt Finder will automatically turn to the 
appropriate page when it opens an EasyArt book.
Close Box

Click the close box to close the EasyArt book.
Remove Color Button

SmartSketch can automatically convert color EasyArt to black-and-white line art. Click the 
Color Button to toggle between black and white and color. When the EasyArt is displayed in 
color, any object dragged into the window will be created in color; however, if the EasyArt is 
displayed in black and white, it will automatically converted to black and white when it is 
dragged into your drawing.
Black-and-white EasyArt is useful when you want to want to print your final drawing to a 
black-and-white laser printer, or when you would like to colorize the EasyArt with your own 
custom colors. Note that you can convert color EasyArt to black and white with the Remove 
Color command after dragging it into your drawing.

Collapse Button

Click the collapse button to toggle the EasyArt book between its full size and displaying just 
the title bar. This is useful when you want to keep several EasyArt books open, but have 
limited screen space.

Resizing the Book
You can change the size of the EasyArt book just like any other window by dragging any 
edge.

See Also
EasyArt Finder
Open as EasyArt command
Creating EasyArt Books



Why Can't I Edit EasyArt?
Answers to Common Questions

Q: Why can't I change EasyArt that I dragged from the floating EasyArt book?
A: By default, EasyArt you drag out of the EasyArt book is in a group object, so you can 

treat it as a single object and it will not accidentally become connected to the rest of 
your drawing. To edit it, either use the Edit Object command to edit the contents, or 
use the Break Apart command to merge the object into the drawing layer.



Why Can't I Import A Bitmap?
Answers to Common Questions

Q: Why can't I import a TIFF or other bitmap file into my drawing?
A: SmartSketch is a drawing program and does not directly support bitmap images. To 

incorporate a bitmap into your drawing, you must use a paint application that supports
embedding objects in other applications. The Paintbrush application that is included 
with Windows 3.1 is an example of this type of application. See Working with Bitmaps 
for more information.



Changing Multiple Styles
Answers to Common Questions

Q: How can I change the color and thickness of multiple lines in my drawing all at the 
same time?

A: First, select all of the lines you want to change, then click on one of the selected lines 
with the Ink Bottle to change all of the selected lines.



Working with Bitmaps

SmartSketch is a drawing application, and uses lines and curves to represent your drawing. 
This is very different from paint applications, which use bitmaps to store your drawings. In 
general, drawings in SmartSketch are easier to modify, take less system resources, and print
at a higher resolution than bitmaps in a paint application. However, there are some 
situations where bitmaps are very useful. For example, you may want to include a scanned 
image in a SmartSketch drawing. Or you may want to convert a SmartSketch drawing to a 
bitmap to use as a wallpaper pattern.
SmartSketch supports bitmaps by working with the Clipboard and embedded objects. This 
means that to work with bitmaps in SmartSketch, you need a paint application that supports 
creating embedded objects, such as the Paintbrush application included with Windows.

Using a Bitmap in a SmartSketch Drawing
To incorporate a bitmap into your SmartSketch drawing:

1. Open the bitmap in your paint application.
2. Select and copy the portion you want to use with the Copy command.
3. Paste it into your SmartSketch drawing.

You should then have an embedded object that you can double-click on and edit in your 
paint application.
Converting a SmartSketch Drawing to a Bitmap - Method 1
To save a SmartSketch drawing as a bitmap:

1. Open your SmartSketch drawing.
2. Select and copy the portion you want to use with the Copy command.
3. Paste it into a new document in your paint application.

Note that some older paint applications may not understand the standard picture format 
that SmartSketch places on the Clipboard. If step 3 does not work, try Method 2.
Converting a SmartSketch Drawing to a Bitmap - Method 2
If your paint application will not paste SmartSketch's picture, or if you want to generate a 
bitmap of the Smooth view of your drawing:

1. Arrange the SmartSketch window so that the your drawing appears in your window 
just like you want it to appear in the bitmap. You may want to use the Toolbars 
command to hide the toolbars.

2. Press Alt-Print Screen to copy a bitmap of the currently active window to the Clipboard.
3. Paste the bitmap into your paint application.
4. Use your paint application to erase the menu bar, window frame and scroll bars from 

the image.



Snap Command
Tools Menu

Snap Button

The snap command is used to enable or disable SmartSketch's automatic snapping. If the 
button is down and the command is checked, snapping is on. If the button is up and the 
menu is unchecked, snapping is off.
Turn on snapping if you want SmartSketch to help you perform actions such as drawing 
straight lines, connecting the end points of lines to nearby lines, and snapping to the grid.
Turn snapping off if this assistance gets in your way. Note that you can tell snapping is on if 
you see a small black circle when dragging or reshaping.
See Snapping for details.



Kerning
Kerning is the amount of spacing between two letters. For high-quality typography, it is 
useful to have precise control over kerning. SmartSketch will automatically use any kerning 
information that is available in a font, and also allows you to manually control the kerning for
special situations.
See Controlling Letter Spacing for more information.



Open as EasyArt Command
File Menu

Use the Open as EasyArt command to open any SmartSketch drawing as a floating EasyArt 
book. This provides an easy way to quickly access reusable drawing components.
Note that it is often more convenient to open the EasyArt that is provided with SmartSketch 
by using the EasyArt Index command in the Help Menu.
See Also

Creating EasyArt Books



Remove Color Command
Tools Menu

Use the Remove Color command to convert the selected portion of the drawing to black-and-
white line art. The Remove Color command will remove the color from the selected lines and
fills as well as the selected group objects. This has the same effect as the Remove Color 
button in the EasyArt Book.
The Remove Color command works by changing any non-black fill to a white fill, and 
changing any non-white line to a black line. Black fills are left as black, and white lines are 
left as white.



Creating EasyArt Books

You can easily create your own EasyArt books, which you can access from a floating EasyArt 
book. Any SmartSketch drawing can be opened in a floating window with the Open as 
EasyArt command but there are a few simple rules to follow if you want to easily drag pieces
out of these windows. Remember, you cannot change a drawing when it is open in a EasyArt
book; you must close the EasyArt book and open that drawing's file with the standard Open 
command to modify it.
Grouping Objects
Only single objects can be dragged out of a EasyArt book, so you need to group your 
drawing into logical pieces that can be dragged out of the window.
Locking
If there are any objects that you do not want to be able to drag out of the EasyArt book, 
simply use the Lock command to lock them.
Rulers and Page Tabs
Since the rulers, page tabs and grid cannot be changed while a drawing is in a EasyArt book,
remember to set these items how you want them before saving the file.
Document Size
Since the EasyArt book is always zoomed to show the entire document page, make sure your
document tightly encloses all of the elements in your file so that the EasyArt book does not 
have excess white space. An easy way to do this is to use the Match Contents button in the 
Document command.



Printing Tips
Reference Information

Printing complex graphics can strain the capacity of any printer. Here are a few tips that may
help if you have problems when printing:

Out of Memory
There are several things to try if you get an out-of-memory or overflow error when printing a 
SmartSketch drawing.

1. Choose a lower Print Quality in the Print dialog box.
2. Increase the size of your margins in the Print Setup dialog box and print your drawing

at smaller scale or on multiple sheets of paper.
3. Use less fonts in your drawing. Large numbers of different fonts on the same page 

can consume printer memory.
4. Study and experiment with the settings in the Printer Options dialog box. Access this 

dialog box through the Options button in the Print Setup dialog box. Try the Help 
button in the Options dialog box for information specific to your printer.

5. Buy more memory for your printer.

See Also
HP LaserJet (PCL) and Compatible Printers
PostScript Printers



Creating Colors

SmartSketch allows you to select any color with the custom color picker in the Colors 
command.
You create a color by adjusting its hue, saturation, and luminosity, or by specifying its red, 
green, and blue values.

Picking a Color Graphically
The large rainbow color box allows you to graphically specify the hue and saturation of a 
color to create. Drag with the mouse to move the plus symbol and pick a hue and saturation.
Moving the mouse vertically changes the saturation, and moving horizontally changes the 
hue.
The luminosity bar allows you to graphically pick the brightness of a color. Drag in the bar to 
change the brightness of the color. The top always specifies white, and the bottom is always 
black.

Picking a Color Numerically
You can enter values in the edit boxes to precisely specify a color.
The Color Box
The color box shows the color as it will appear on the screen. The solid color box shows the 
nearest solid color. Double-click this box to choose the closest solid color for the best-looking
screen display.



Hue
The position of a color along the color spectrum. For example, green is between yellow and 
blue.



Saturation
The purity of a colors hue, moving from gray to the pure color.



Luminosity
The brightness of a color on a scale from black to white.



Grid
SmartSketch can optionally display and snap to a drawing grid to help you create precise 
drawings. This works much like drawing on graph paper. Use the Document command to 
change the grid settings.



Clipboard
A temporary storage area for cut or copied graphics or text. You can paste the contents of 
the Clipboard into a SmartSketch document or into a file created in another application. The 
Clipboard retains the information until you cut or copy other graphics or text.



Ordering SmartSketch
Contents

If you find this trial version of SmartSketch useful, you can purchase the complete version of 
SmartSketch from your local retailer or direct from FutureWave Software.
Special Offer
You can purchase SmartSketch 1.0 for Microsoft Windows directly from FutureWave Software 
for a special introductory price of $79.95 through December 31, 1994. The regular list price 
is $99.
To order by phone with your credit card, simply call 800-619-6193 or 619-637-6190. To order 
by mail or for pricing details, click Order Form.
Complete Version
The complete version of SmartSketch includes everything this trial version contains plus:

Over 600 EasyArt images in 17 different books. See the EasyArt Finder for a detailed 
listing.

Eight on-screen lessons that teach you how to use SmartSketch and basic drawing 
techniques. See Learning SmartSketch for more information.

Automatically add a SmartSketch button to the Microsoft Word and Microsoft Excel 
toolbars for even better OLE 2.0 support.

A subscription to the FutureWave newsletter for information on product updates and tips 
on using SmartSketch.

Technical support direct from FutureWave.
No time limit. Use SmartSketch for as long as you like.
Printed Getting Started Guide.
Complete support for drawings created with this Trial Version.



SmartSketch Order Form
To print this form, choose Print Topic from the File menu.
Address:
Name: ________________________________________________
Company: ________________________________________________
Street: ________________________________________________
City: ________________________________________________
State: _______________________ Zip Code: ___________
Phone: (_____) _____ - _________
Sales Information:
Product: $ _______

SmartSketch 1.0 Windows (through 12/94) $79.95
SmartSketch 1.0 Windows (after 12/94) $99.00

Sales Tax: $ _______
San Diego County Residents ( 7% ) @ $79.95 = $5.60, @ $99 = $6.93
Other California Residents ( 7.25% ) @ $79.95 = $5.80, @ $99 = $7.18
Outside California ( 0% )

Shipping Charge: $ _______
2-Day Delivery $ 8.00
UPS Ground (about 1 week) $ 5.00
Canada (UPS Ground) $ 11.00
Overnight $ 17.00

Total $ _______
Payment:
Payment Method: __ Check __ Visa __ MasterCard

Make check/money order payable to FutureWave Software, Inc.
Credit Card Number: _______ - _______ - _______ - _______
Expiration Date: ___ / ___
Signature: ____________________________

To order, call 800-619-6193 or mail this form with payment to:
FutureWave Software, Inc.
8305 Vickers St., #200
San Diego, CA 92111



Handle
Handles are drawn as small rectangles or ovals on your drawing. They indicate a location 
where you can drag with the mouse to perform a special function such as rotating or scaling 
the selection.



Printing Text on an HP LaserJet
Answers to Common Questions

Q: Why does the text always print on top of the graphics in my drawing or not print at all 
with my HP LaserJet or compatible printer?

A: By default, the HP LaserJet printer driver always print texts on top of any graphics on 
the page. This allows the printer to print large amounts of text more quickly. Also, text 
that is partially on the printer page may not print at all. For printing most drawings in 
SmartSketch, select the Print TrueType as Graphics option in the Printer Options dialog.
See Printing Tips for more information.



Printer Options Dialog
The Printer Options dialog box has custom options that are specific to a particular type of 
printer. Access the dialog box by pressing the Options button in the Print Setup command.
Most users should not need to access this dialog box, but you should examine the settings in
it if you are have difficulty printing from SmartSketch, or if you want to access a special 
feature of your printer.



Installing and Removing Components of SmartSketch
Reference Information

Occasionally, you may want to modify your SmartSketch installation after you have installed 
SmartSketch. For example, if you did not install all of the EasyArt or lesson files, you can add
them. You can free up space on you hard disk by removing EasyArt or lessons that you don't 
use, or you can to move SmartSketch to another hard drive or computer.
You can use the Print command in the File menu to print out these step-by-step instructions 
for easier reference.
Adding EasyArt or Lessons
To add EasyArt or lesson files to SmartSketch that you did not initially install:

1. Run the Setup application on the original SmartSketch floppy disks.
2. Choose the Custom install option. If you specified a custom directory or drive location

when you initially installed SmartSketch, be sure to specify the same location when 
adding components.

3. Select the components you wish to add to your installation and install them.

Removing EasyArt or Lessons
To remove EasyArt or lesson files that you do not use:

1. Run the File Manager.
2. Find the directory that contains the SmartSketch application. This will normally be C:\

SKETCH unless you specified a custom location when you installed SmartSketch. If 
you are not sure where it is, search for SKETCH.EXE.

3. To remove EasyArt, simply delete any of the .SSK files in the \SKETCH\EASYART 
directory.

4. To remove lessons, delete any of the .SSK files in the \SKETCH\LESSONS directory. 
Note that by default SmartSketch marks these files as read-only so that you cannot 
accidentally modify them. Simply answer yes when the File Manager asks if you really
want to delete them.

Removing SmartSketch
To remove SmartSketch from your computer completely:

1. Delete the entire \SKETCH directory. Be sure to save any of your drawings that might 
be in the \SKETCH\DRAWINGS directory.

2. Delete the SKETCH.INI and SKETCH.CLR files in the WINDOWS directory.
3. Choose the Run command under the File menu in the Program Manager and enter 

REGEDIT to run the Registration Info Editor.
4. Search for SmartSketch Drawing in the list of file types and use the Delete command in 

the File menu to delete it.
Note that SmartSketch may also add files that support OLE 2.0 and the 3-D dialog look to 
your \WINDOWS\SYSTEM directory, but it is not safe to delete them since other applications 
on your computer may depend upon them.
Moving SmartSketch to Another Computer or Directory
The safest way to move SmartSketch to another computer or to another hard drive on your 
computer is to remove it (as described above in Removing SmartSketch) and then run the 
SmartSketch Setup application to reinstall it from the original disks.
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Why Doesn't My Document Size Change?
Answers to Common Questions

Q: Why doesn't the size of my document change when I change the margins, orientation, 
or paper size with the Print Setup command?

A: SmartSketch keeps track of the dimensions of your drawing independently from the 
printable area of the printer. This prevents your drawing from being modified when you
switch printers, and lets you to create drawings that are larger than your printer paper 
and print on multiple sheets of paper.
If you would like the size of your drawing to exactly match the printable area on your 
printer, simply press the Match Printer button in the Document command; SmartSketch
will calculate the proper document size for you.



PostScript Printers
Printing Tips

If you get a limit check or overflow error on your PostScript printer, it may be because one of
the filled areas in your drawing is too complex. This is more common with older PostScript 
Level 1 printers. There are two solutions to this problem: You can try checking the Disable 
PostScript option in the Print Setup dialog box. This should solve a limit check problem, but 
can make printing extremely slow. Alternatively, you can simplify your drawing. These errors 
are typically a result of a single large area of color with complex borders. You can simplify 
this by dividing a single complex area into several simpler areas.
For information on generating color separations and other PostScript issues, see Working 
with EPS Files.



HP LaserJet (PCL) and Compatible Printers
Printing Tips

For most SmartSketch documents, it makes sense to select Print TrueType as Graphics in the 
Printer Options dialog box. This should solve any problems that you have with text printing 
on top of your graphics. It also may reduce the amount of printer memory needed to print 
documents with many different fonts in them.
Text that is partly off the printer page may not print unless you select Print TrueType as 
Graphics. This is particularly important if you are printing a large drawing tiled onto multiple 
pages.
If you use an HP LaserJet III or 4, be sure to use the latest version of the printer driver from 
Microsoft or Hewlett-Packard. The latest versions, as of this writing, are version 31.1.89 for 
LaserJet III and version 31.1.35 for the LaserJet 4.
If you receive Error 21 (Print Overrun) messages when you print to an HP LaserJet 4 printer, 
try these workarounds:

1. Use the Windows Control Panel to verify that you are using the 31.1.35 printer driver 
or later. Updates to the LaserJet 4 driver can be obtained in the CompuServe (HPPERI 
forum) or through HP.

2. Set the correct amount of printer memory in the Control Panel. This should match 
what you actually have on your printer. Please refer to the printer documentation for 
information on how much memory you need.

3. Set the graphics mode to Raster rather than HP-GL/2. Although the HP-GL/2 mode is 
faster, often you can print more complicated pages using the Raster mode.

4. Try using the Page Protect feature for the paper size you're using. Please refer to the 
documentation that came with your printer for additional information on the Page 
Protect feature.

5. Try printing at 300 dpi rather than 600 dpi.
6. If none of the above options help, install the HP LaserJet III driver in addition to the HP

LaserJet 4 driver. Use the HP LaserJet III driver to print at 300 dpi to the HP LaserJet 4 
printer.



Quick Tips
Contents

Here are some useful tips for working with SmartSketch:
1) Review the Basic Drawing Concepts section for a better understanding of fundamental 

drawing concepts in SmartSketch. Important concepts include: the difference between 
lines and fills, the automatic connection of lines when they touch, the difference 
between the drawing and object layers, selecting, and zooming.

2) Use the arrow keys to nudge the selection by small amounts. 
3) Use the keyboard to quickly switch tools.
4) Use the Paint Bucket to fill enclosed areas and change the colors of fills. Use the Ink 

Bottle to change the color and style of lines.
5) Refer to Using SmartSketch with Other Applications for information in using your 

SmartSketch drawings in other applications.
6) Use the Smooth and Straighten commands when reshaping for precise control over 

curves.
7) Double-clicking with Arrow tool is a useful shortcut for selected parts of your drawing 

and for activating objects for editing.



About the Trial Version
Contents

This trial version of SmartSketch is designed to provide an economical way for you to try 
SmartSketch before purchasing the complete SmartSketch. You may use the trial version of 
SmartSketch for a maximum of 30 days. If you wish to continue using SmartSketch after this 
period, you need to purchase the complete version from FutureWave Software, or your local 
retailer.
Refer to Ordering SmartSketch for details on ordering the complete version of SmartSketch.
This trial version may be downloaded from an on-line service, purchased from FutureWave or
shared between friends.






